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Preface

About this guide
This guide explains how to use the Fragment Analysis software to analyze 
DNA and protein fragments separated by electrophoresis. The manual is 
divided into three parts:

• Part one: Basics—Provides introductory information and step-by-step 
procedures for performing an analysis. Part one also includes a tutorial 
(chapters 3 and 4) that walks you through an analysis session, from 
loading an image to creating a report. The final chapter in part one 
explains how to analyze dual-channel images.

• Part two: Reference—Provides information about all the items on 
the Fragment Analysis menus.

• Part three: Appendixes—Includes report examples, technical 
information about how Fragment Analysis calculates band values, 
and a troubleshooting guide.

Assumptions
The instructions in this manual assume you have basic computer skills. 
You should be familiar with a Windows-based graphical user interface 
and know how to use a mouse. If you do not have these skills, refer to
the Microsoft™ Windows™ documentation. 
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Assistance
If you have problems, please contact:

Asia Pacific  Latin America
Tel: +852 2811 8693 Tel: +55 11 3667 5700 
Fax: +852 2811 5251 Fax: +55 11 3667 87 99 

Australasia  Middle East and Africa 
Tel: +61 2 9899 0999 Tel: +30 (1) 96 00 687
Fax: +61 2 9899 7511  Fax: +30 (1) 96 00 693

Austria  Netherlands 
Tel: 01 576 0616 22 Tel: 0165 580 410
Fax: 01 576 0616 27  Fax: 0165 580 401

Belgium  Norway
Tel: 0800 73 888 Tel: 2318 5800
Fax: 03 272 1637  Fax: 2318 6800

Canada  Portugal 
Tel: +1 800 463 5800 Tel: 21 417 70 35
Fax: +1 800 567 1008  Fax: 21 417 31 84

Central, East, and Southeast Europe  Russia & other C.I.S. & N.I.S.
Tel: +43 1 982 3826 Tel: +7 (095) 232 0250, 956 1137
Fax: +43 1 985 8327  Fax: +7 (095) 230 6377 

Denmark  Southeast Asia
Tel: 45 16 2400 Tel: +60 3 8024 2080
Fax: 45 16 2424  Fax: +60 3 8024 2090

Finland & Baltics  Spain
Tel: +358 (0)9 512 39 40 Tel: 93 594 49 50
Fax: +358 (0)9 512 17 10 Fax: 93 594 49 55 

France Sweden
Tel: 01 69 35 67 00 Tel: 018 612 1900 
Fax: 01 69 41 96 77 Fax: 018 612 1910 

Germany  Switzerland 
Tel: 0761 4903 291 Tel: 01 802 81 50
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http://www.amershambiosciences.com 
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Chapter 1 The Fragment Analysis 
workflow

The Fragment Analysis software provides the tools and processing power to—

• Set up the layout of your experiment for DNA fragment analysis, protein 
band analysis, and isoelectric point determination.

• Find lanes and bands automatically.

• Edit lanes and bands manually.

• Calculate sizes, amounts, and isoelectric points of bands.

• Examine the image with special viewing tools. 

• Obtain reports of size, amount, and migration statistics about any band 
in the sample.

• Perform two-color analysis.

• Transfer data to a Microsoft Excel spreadsheet.

• Automate the entire analysis process.

The software steps you through the analysis process, beginning with setting up 
the experiment and ending with obtaining a report. 

The topics in this chapter are—

• Setting up the experiment (section 1.1)
• Performing the analysis (section 1.2)
• Creating a report (section 1.3)
• Automating the analysis (section 1.4)
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1.1 Setting up the experiment
You begin a session by setting the experiment parameters, such as the number 
of lanes in the sample (figure 1-1).

Figure 1-1.   Accessing the forms for setting up the experiment format. 
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1.2 Performing the analysis
Next, you load the image you are analyzing. Fragment Analysis then steps you 
through the analysis process by displaying inspectors—a series of windows for 
entering additional specifications or for confirming the results (figure 1-2).

Figure 1-2.   The inspector sequence.

Image Setup Image Setup

Lane Finder Band Finder

Lane Setup Band Statistics
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1.3 Creating a report
You can select from a variety of report formats, and then transfer the results to 
an Excel spreadsheet (figure 1-3) or export the results to a file for later retrieval 
in a word processing or database application.

Figure 1-3.   Transferring results to a spreadsheet.
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1.4 Automating the analysis
After you create a form for a typical sample, you can use the form to analyze 
similar samples automatically. You do this by loading the form, selecting the 
steps you want to automate (figure 1-4), and then loading the image. After you 
load the image, Fragment Analysis can perform a complete analysis without 
intervention on your part, unless a problem arises.

Figure 1-4.   Selecting automation options.
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Chapter 2 Getting started

This chapter provides the information you need to start using the Fragment 
Analysis software. The topics in this chapter are—

• Starting the Fragment Analysis software (section 2.1)
• Understanding the toolbar (section 2.2)
• Using inspectors (section 2.3)
• Quitting the Fragment Analysis software (section 2.4)

2.1 Starting the Fragment Analysis software 
After you log on to the Windows desktop, you double-click the Fragment 
Analysis shortcut icon on the desktop. If you do not see the icon, you can start 
Fragment Analysis using the Start menu. The Fragment Analysis main window 
appears (figure 2-1). 

When Fragment Analysis first appears, three menu items are displayed: File, 
Window, and Help (figure 2-1). As you begin working on various tasks, the 
menu items change according to the task you are performing.

The status bar, at the bottom of the window, displays messages about the 
function of current selections as well as the name of the Experiment Form 
you are using.
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Figure 2-1.   Starting the Fragment Analysis software.
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2.2 Understanding the toolbar
After you load an image, a toolbar appears at the edge of the Fragment 
Analysis window (figure 2-2). The toolbar provides a handy way to access 
various functions. (The last three buttons on the toolbar do not appear until 
you reach the band-finding step.) 

To use a tool, click the button. If you place the pointer on an image, the pointer 
changes to a different shape, depending on the tool you select. 

For detailed information about the toolbar options, see chapters 7 and 8.

Figure 2-2.   The toolbar.

Select—Return to select mode

Pan—Scroll image by dragging

Pixel Locator—Display pixel location and value

Pixel Distance—Determine the distance between two pixels

Zoom Area-Create Frame—Enlarge the framed area

Zoom Area-Previous—Reduce and view previous frames

Map—Show or change the portion of the total image currently displayed

Magnifier—Magnify selected area

Channel 1—Display channel 1 image

Channel 2—Display channel 2 image

Side by Side (Two Color)—Display images side by side in two colors

Overlay—Display composite dual image

Grey/Color Adjust—Adjust image display

Add Band (Manual)—Draw a band centered in the drawn box

Add Band (Semiauto)—Draw a band centered at area of max. intensity

Delete Band—Delete a selected band
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2.3 Using inspectors
To perform an analysis, you use inspectors. Inspectors are windows designed to 
set up and initiate a specific task or to display results (figure 2-3). For example, 
you use one inspector to find bands and another to set up standards.

As you go through the analysis, Fragment Analysis presents each inspector
in sequential order, beginning with the Image Setup inspector. After you click 
Done, Fragment Analysis displays the next inspector. You can also access 
inspectors from the Analysis menu (which appears after you load an image)
or from within the currently displayed inspector.

Inspectors have the following features (figure 2-3):

• Panes—Displays the current inspector name and contains a list of 
inspectors you have already used. You can return to a previous step by 
selecting the inspector from the list.

Note: Because each step of Fragment Analysis builds on the preceding step, 
the list of available inspectors depends on the stage of analysis you have 
reached.

• Help button—Displays information about the inspector.

• Done button—Finalizes the step and displays the next inspector in the 
series.

Figure 2-3.   Example of an inspector.
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2.4 Quitting the Fragment Analysis software 
To quit the Fragment Analysis software, save the results of your analysis. Then 
from the File menu, click Exit. The Fragment Analysis main window closes.
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Chapter 3 Fragment Analysis 
step-by-step

This chapter takes you through a complete fragment analysis session. Before 
you begin analyzing your own data, use this chapter as a tutorial to learn 
how to analyze the provided image. The tutorial image file is named tutor1.ds. 
(The tutor2.ds image file is a dual-channel image that can be used in chapter 5). 
To use this chapter as a tutorial, look for the words, “To try it now…” on each 
odd-numbered page.

To begin the tutorial, display the Fragment Analysis main window, as described 
in section 2.1.

Note: During the course of the tutorial, you will be creating files and giving 
them names specified in the tutorial. If someone has used the tutorial before 
you, a message will appear when you save certain files asking if you want to 
replace the existing file with the new file. Click Yes/OK.

The topics in this chapter are—

• Accessing the Experiment Form (section 3.1)
• Setting up the experiment (section 3.2)
• Entering the lane setup information (section 3.3)
• Saving the Experiment Form (section 3.4)
• Loading the image (section 3.5)
• Adjusting the image display (section 3.6)
• Preparing the image for analysis (section 3.7)
• Finding the lanes (section 3.8)
• Reviewing the lane setup information (section 3.9)
• Creating a standards file (section 3.10)
• Finding the bands (section 3.11)
• Reviewing the band statistics (section 3.12)
Fragment Analysis User’s Guide ● p3-1



 

Part one   Basics

                    
3.1 Accessing the Experiment Form
You begin an analysis session by entering the information, such as number
of lanes and locations of size standards, that Fragment Analysis uses to 
calculate data for the unknowns. You enter this information into an 
Experiment Form. 

3.1.1 Creating a new form
To access a new form, open the File menu and select Experiment Form, 
and then select New from the submenu (figure 3-1). The Experiment Form 
window appears.

3.1.2 Three ways to use a form
You can use the Experiment Form as—

• A record of your experiments. In this case, you can create a new form
for each analysis you perform.

• A template or method for running experiments that use the same 
parameters. In this case, select the Open option, and then, after the 
form appears, click the Close button.

• A basis for creating new forms. For similar experiments, you can retrieve 
an existing form (select the Open option), modify it, and then save it 
under a new name.

The form you use remains in effect until you select a new form, close the 
application, or unload a previously loaded form. To unload a previously 
loaded form (at either the beginning or end of the analysis session), open 
the Experiment Form menu and select Close from the submenu.
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3.1.3 Working without a form
You can perform an analysis without first creating a form. In this case, you 
load your image, and then enter your specifications into the inspectors as they 
appear during the course of an analysis session. At the end of the analysis, the 
entries you made in the inspectors are automatically stored in a form, which 
you can then choose to save.

Figure 3-1.   Opening the Experiment Form window.

To try it now…

1. On the main menu bar, click File to display the File menu.

2. In the File menu, click Experiment Form. A menu of options appears 
(figure 3-1).

3. From the list of options, select New. The Experiment Form window 
appears (figure 3-2).

4. Go to section 3.2.
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3.2 Setting up the experiment
To set up the experiment, enter information into the form (figure 3-2). 

3.2.1 Entering the experiment setup information
Enter information in the Experiment Form as follows:

• Optional Entries—The Experiment ID, Date, and General Comments 
boxes are for your records only.

• Defaults—The Channel, Experiment Type, and Interpolation boxes 
contain default values. If the displayed defaults are not appropriate for 
your experiment, choose another selection from the list.

• Number of Lanes—Enter the number of lanes that are in your sample.

• Standards Files—The buttons in the Standards Filenames area provide 
access to windows from which you can select the standards files to use with 
your experiment. (If the file you need does not exist, you can create the file 
at a later step.)

3.2.2 Entering the lane identification information
To enter lane identification information, first enter the number of lanes, and 
then click Lane Setup. The Lane Setup window appears (see section 3.3). 

3.2.3 Automating the analysis
After setting the experiment parameters, you can automate the analysis by 
selecting options from the Automation Options window, which you open by 
clicking the Automation button. For information on using the Automation 
feature, see section 4.7.

3.2.4 For more information
For detailed information about choices in the Experiment Form, see 
section 6.1. For information about analyzing dual-channel images, see 
chapter 5.
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Figure 3-2.   Setting up the experiment.

To try it now…

1. Click Today. Today’s date appears in the Experiment Date box (figure 3-2).

2. Double-click the Number of Lanes box, and then type 9. You will leave the 
other text boxes blank and accept the defaults in the selection boxes.

3. Click Lane Setup. The Lane Setup window appears.

4. Go to section 3.3.
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3.3 Entering the lane setup information
After you click the Lane Setup button, the Lane Setup window appears 
showing the number of lanes you typed in the Experiment Form. Use the 
Lane Setup window to identify standards lanes and enter other identifying 
information about the lanes.

3.3.1 Identifying the standards
To identify the standards lanes, display the Type list, and then select the 
appropriate type:

• Size standards define the molecular weight of each band.

• Amount standards define the amount of DNA or protein in each band. 

• pKI standards define the isoelectric point of each band.

Optionally, you can also type Lane Name and Description information. 

Next, in the lane list box, click one or more of the lanes that represent 
standards. (To select more than one lane at a time, hold down the CTRL key 
while you click the lanes.) 

After making your selections, click Set. The lane list is updated with the new 
information (figure 3-3).

Because all bands are initially labeled Unknown, adding information about 
unknown lanes is not required. To add identifying information, such as
Lane Name, use the same technique as for identifying standards.

3.3.2 Changing the information
To change the information about the lanes, click the lane to select it, change the 
information in the selection and text boxes near the top of the window, and 
then click Set. To add a lane, click a lane, and then click Insert. A new lane is 
added after the lane you selected. To remove a lane, click the lane, and then 
click Remove.
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Figure 3-3.   Identifying standards lanes.

To try it now…

1. Click the down arrow ( ) next to the Type box. A list of lane types 
appears. Click Size Std.

2. Click in the Lane Name box, and then type HMN.

3. CTRL+click Lane 1, Lane 5, and Lane 9. All three are highlighted. 

4. Click Set. The lane list is updated with the new information (figure 3-3).

5. Click OK. The Lane Setup window closes.

6. Go to section 3.4.
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3.4 Saving the Experiment Form
To save the Experiment Form, click Save. The Save Form File window 
appears (figure 3-4). Type a name for the form in the File Name box, and
then click OK. Fragment Analysis adds a .frm file extension. Alternatively, 
you can accept the default name, form1.frm, in which case the next default 
name will be form2.frm, and so on. (See section 6.1.10 for information 
on file name restrictions.)

3.4.1 How the form affects the analysis
Fragment Analysis uses the information you entered into the form as input for 
the analysis session. The current form remains in effect until you create a new 
form, load another form, or unload the form. 

3.4.2 Unloading a form
If, after loading a form, you decide to analyze a sample without using the 
form, you can close the form you loaded. To do this, from the File menu, select 
Experiment Form, and then select Close from the submenu. Note that you 
can close a form only at the beginning or end of an analysis session (at the 
Image Setup inspector or at the Band Statistics inspector), or before an image 
is loaded.

3.4.3 Retrieving a form: Open versus Show
The Open and Show commands, available from the Experiment Form 
submenu, serve different purposes—

• Use the Open command to load the form you want to use for the analysis 
or to modify an existing form.

• Use the Show command at the end of the analysis session to view the 
currently loaded form. Because Fragment Analysis retains changes you 
make during the analysis, you can use the Show command to retrieve 
the form and save the changes to update your form. 
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Figure 3-4.   Saving the Experiment Form.

To try it now…

1. In the Experiment Form, click Save. The Save Form File window appears 
(figure 3-4).

2. In the File Name box, type sample1, and then click OK. The window 
closes. Fragment Analysis adds the .frm file extension to the file name and 
replaces Form1.frm on the title bar of the form with the name of the file.

3. In the Experiment Form window, click Close. The window closes.

4. Go to section 3.5.
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3.5 Loading the image
After setting up the experiment, you select and load an image file. Loading the 
image begins the analysis session. If you did not load or create an Experiment 
Form, you enter the experiment information in the inspectors as you proceed 
through the analysis.

3.5.1 Selecting an image file
To select an image file to load, display the File menu and click Open Image. 
The Open Image window appears (figure 3-5). In the list of files box, locate the 
file you want to analyze, and then double-click the file name (or click the file 
name, and then click OK). 

If you do not see the file name, use the scroll bars to reveal hidden file names. 
Also check the List Files of Type box to make sure that the correct file type is 
displayed (usually MD Files *.ds, *.gel), and check the Drive and Directory 
areas. (Typically, image files are stored in the \data directory in drive c.)

Note: For additional details on using the Open Image window, including 
information about the directory structure, see section 6.3.

3.5.2 After loading the file
After you load the file, the following events occur:

• A progress bar appears on the screen, indicating that the file is being 
loaded. 

• The image appears sized to fit the available space on the screen.

• Two rectangles, large and small, are overlaid on the image.

• The Image Setup inspector appears (figure 3-6). If you created an 
Experiment Form, the settings you selected for Number of Lanes, 
Experiment Type, Interpolation, and other information are displayed
in the inspector.

• The name of the form appears on the right side of the status bar.
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Figure 3-5.   Selecting the file to process.

To try it now…

1. On the main menu bar, click File to display the File menu.

2. Click Open Image. The Open Image window appears (figure 3-5).

3. In the Directories box, double-click the tutor directory located under the 
data directory. Two file names appear in the file names list box.

4. Double-click tutor1.ds. A progress bar appears, followed by the image and 
the Image Setup inspector. The Number of Lanes, Experiment Type, and 
Interpolation parameters specified in the Experiment Form appear in the 
inspector (figure 3-6).

5. Go to section 3.6.
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3.6 Adjusting the image display
The Fragment Analysis software includes many features that allow you to 
adjust the screen display. Below are some examples of these features. For 
a complete discussion, see chapter 7 (View menu reference) and chapter 8 
(Tools menu reference).

3.6.1 Moving and hiding the inspectors
To move an inspector, place the pointer on the inspector title bar and drag the 
inspector to a new location. To hide an inspector, double-click the inspector 
control menu button ( ). To show the inspector, open the Analysis menu and 
click the inspector name.

3.6.2 Scrolling the image
For images that are larger than the Image window, several scrolling tools are 
available: the window scroll bars, the Pan tool ( ), and the Map window 
tool ( ). The Pan tool, available from the Tools menu or toolbar, allows you 
to move the image in any direction. The Map window, available from the View 
menu and toolbar, displays a small replica of the entire image with an outline 
showing the currently displayed area. You move the outline to shift the image 
display.

3.6.3 Optimizing the image display
If the image is difficult to see, you can adjust the grey-scale range or invert 
the grey tones of the image using the Grey/Color Adjust window (figure 3-6), 
available from the View menu or toolbar ( ). Section 7.6 explains how to 
use the Grey/Color Adjust window.

3.6.4 Enlarging and reducing the image
Both the View and Tools menus offer options for changing the image display. 
For example, to scale the image to fit the window, select Full Size from the 
View menu. To magnify a particular region of the image, select Magnifier from 
the Tools menu or toolbar ( ).
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Figure 3-6.   Adjusting the image display.

To try it now…

1. Click the Grey/Color Adjust toolbar button ( ) to open the 
Grey/Color Adjust window (figure 3-6).

2. Move the pointer to the title bar of the Grey/Color Adjust window and 
drag the window so that it does not cover the image.

3. Move the pointer to the top of the range adjust bar (figure 3-6), drag the 
pointer down until the middle of the darkest bands begin to appear green, 
and then release the mouse button. The bands appear darker.

If the color appears purple instead of green, click Reset, and start again.

4. Click Set Range to save the changes (the changes affect the display only), 
and then click Close to close the Grey/Color Adjust window. 

5. Go to section 3.7.

Top of range adjust bar
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3.7 Preparing the image for analysis
When the image appears on the screen, a large red rectangle and small green 
rectangle are overlaid on the image. The rectangles define the region you want 
to process and the approximate size of the bands. The Image Setup inspector 
includes a tool for rotating the image plus input areas for entering experiment 
setup specifications.

3.7.1 Understanding the rectangles
The two rectangles on the image serve the following purposes (figure 3-7):

• Small rectangle—Defines the approximate band size and lane width for the 
analysis. Move and resize this rectangle to surround the largest band. Make 
sure that the rectangle closely outlines the band edges.

• Large rectangle—Defines the region you want to analyze. Resize this 
rectangle to exclude from the analysis unwanted areas of the image, such 
as the wells at the top of the image. Set the top boundary at the bottom 
edge of the wells. Set the right and left boundaries within half a lane-width 
of the outermost bands (the rectangle edges should be close to—but not 
touching—the edges of the outermost bands). 

3.7.2 Moving and resizing the rectangles
To move or resize a rectangle, you must first select it. Place the pointer within 
one of the rectangles and click the mouse button. Small square “handles” 
appear at the corners. To move the rectangle, place the pointer inside the 
rectangle and drag the rectangle to a new position. To resize a rectangle, place 
the pointer on one of the corner handles and drag the corner to a new position.

3.7.3 Rotating the image
To rotate an image that is not squarely aligned in the Image window, click
the image rotation button ( ). A red line with black handles at both ends 
appears on the image. Drag the handle to indicate the degree of rotation, and 
then click on Rotate. The image rotates to the degree indicated by the line. For 
complete instructions on rotating, see section 9.1.
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Figure 3-7.   Adjusting the region of interest and band prototype rectangles.

To try it now…

1. Place the pointer inside the small rectangle and drag the rectangle to 
enclose the largest band (figure 3-7).

2. Resize the small rectangle to fit the band: Place the pointer on one of the 
black handles and drag the handle right or left, up or down.

3. Click the large rectangle. Handles appear at the corners. 

4. Use the handles to adjust the size of the large rectangle:

Pull the top and outside edges inward so that they are close to—but not 
touching—the bands.

Pull the lower edge up to exclude the bottom row of bands from the region 
of interest (figure 3-7).

5. Click Done. The Lane Finder inspector appears with a rectangle over the 
first lane in the Image window. 

6. Go to section 3.8.

Small rectangle

Large rectangle
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3.8 Finding the lanes 
At the same time that the Lane Finder inspector appears, a rectangle appears 
on the first lane in the image. The Lane Finder inspector allows you to initiate 
automatic lane finding. The rectangle serves as the prototype lane marker.

3.8.1 Adjusting the lane marker
The rectangle surrounding the first lane serves as a pattern for finding the 
remaining lanes. If the rectangle does not correctly delineate the lane, move it 
or resize it, using the same techniques discussed in section 3.7.2. Note that you 
cannot change the height of the rectangle, only its width and position.

3.8.2 Initiating lane finding
To initiate lane finding, click Find Lanes. Fragment Analysis encloses the found 
lanes with rectangles and displays the number of lanes it found (figure 3-8). 
(The software finds the number of lanes you specified in the Experiment Form 
or Image Setup inspector.)

3.8.3 Editing the lane markers
You can move and resize lane markers to fit the lanes. You can also add and 
delete the markers—

• To add a lane marker—Click a lane marker, and then click the duplicate 
button ( ). A rectangle encloses the lane to the right of the selected lane. 

• To delete a lane marker—Click the lane you want to delete, and then click 
the delete button ( ) (or the DELETE key). The lane marker disappears.
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Figure 3-8.   Finding lanes.

To try it now…

1. Place the pointer inside the rectangle in the Image window, and drag the 
rectangle left or right to make sure that it uniformly surrounds the lane.

2. Click Find Lanes. The lanes are marked with rectangles and the number of 
found lanes is displayed (figure 3-8).

3. Review the placement of the rectangle markers and move or resize them to 
make sure that each lane is accurately defined.

4. Click Done. The Lane Setup inspector appears (figure 3-9).

5. Go to section 3.9.
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3.9 Reviewing the lane setup information 
When the Lane Setup inspector appears (figure 3-9), the lane identification 
information you entered in the Lane Setup window of the Experiment Form 
is shown in this inspector. 

3.9.1 Identifying the standards lanes
The Lane Setup inspector is the counterpart of the Lane Setup window, 
which you use to set up the experiment (section 3.3). If you did not enter
the lane setup information into the Lane Setup window, you can use the 
same techniques to enter the information into the inspector. 

Note: To select lanes, you can click the lanes in the Image window as well as
in the Lane List. To select multiple lanes in the Image window, hold down the 
SHIFT key while you click the lanes.

3.9.2 Returning to a previous inspector
To return to a previous inspector, such as the Lane Finder, click anywhere in 
the Panes box to reveal the inspector options, and then click an option. After 
returning to a previous inspector, you must proceed through the normal 
sequence of inspectors by clicking Done in each one.

Note: Because each step of Fragment Analysis builds on the preceding step, the 
list of available inspectors depends on the stage of analysis you have reached.
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Figure 3-9.   Identifying lanes.

To try it now…

1. In the Lane Setup inspector, examine the lane list. Lanes 1, 5, and 9 should 
be identified as size standards and HMN should appear on the image.

2. Click the Panes box. A list of inspectors appears (figure 3-9).

3. Click Lane Finder. The Lane Finder inspector appears.

4. Click Done. The Lane Setup inspector appears.

5. Click Done. The Standards Setup inspector appears.

6. Go to section 3.10.
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3.10 Creating a standards file
The Standards Setup inspector (figure 3-10) allows you to create, load, or 
modify a standards file. The standards file provides the information the 
software uses to compute the unknowns. 

3.10.1 Creating a new standards file
To create a new standards file, first select the type of file you will be creating 
by clicking one of the buttons in the Type area. Next, in the Unit box, type
the appropriate unit for the value, such as bp, kb, or ng. In the Order box, 
select the order in which you want the values listed.

Finally, in the Value box, type the first value, and then click Add or press 
ENTER. The system adds the value to the list, inserting it in an appropriately 
sorted order. Repeat to add more values. 

To remove a value from the list, click the value, and then click Delete. To 
change a value, click the value, type a new value in the Value box, and click 
Change. To insert a value, type a new value in the Value box, and then click 
Add. The value is inserted in the appropriate ascending or descending order.

3.10.2 Saving the new standards file
To save the new file, click the Save As button. The Save Size/Amount Standard 
window appears. In the File Name box, type a name for the file, and then 
click OK.

3.10.3 Loading an existing standards file
To load an existing standards file, select the standards type, and then click 
Open to display the Open Size/Amount File window. Double-click the desired 
standards file (or click the file name, and then click OK). The band values 
appear in the Editor area of the inspector. (If you selected the wrong file, you 
can select a new one.) 

If a single standard serves as both size and amount standards, first load one 
standards file type, and then the other. (Remember to specify the type before 
clicking Open.)

For more information about using the Standards Setup inspector, see 
section 9.4.
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Figure 3-10.   Creating a standards file.

To try it now...

1. In the Standards Setup inspector, make sure that the Size Std. button is 
selected in the Type area and that Descending is selected in the Order area.

2. Click the Value box, type 1300, and then click Add (or press ENTER). 
The value, 1300, appears in the list of values box (figure 3-10).

3. Next, type 1200 in the Value box and click Add. Continue entering values, 
in decreasing 100 increments, until you reach 100. (You should have 13 
entries. Use the scroll bar to check.)

4. Click Save As. The Save Size File window appears.

5. In the File Name box, type SIZESTD, and then click OK. (Fragment 
Analysis adds the .siz file extension to the file name.)

6. Click Done. The Band Finder inspector appears (figure 3-11).

7. Go to section 3.11.
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3.11 Finding the bands
The Band Finder inspector (figure 3-11) initiates and controls the automatic 
band-finding process. When the Band Finder inspector appears, the Setup 
area displays the number of bands in your standards file as well as the default 
band-finding parameters. 

In addition, three band-editing buttons are added to the toolbar (see 
section 4.2.1 for an explanation of the buttons).

3.11.1 Initiating the band finding
The Scope area allows you to specify the lanes for which you want Fragment 
Analysis to find bands. First, click one of the selections in the Scope area (the 
default is All Lanes), and then click Find Bands. Fragment Analysis locates the 
bands and marks the band positions and boundaries.

3.11.2 Evaluating the band finding
Check the image to see if Fragment Analysis located the bands. Then—

• If band finding was satisfactory, click Done.

• If Fragment Analysis incorrectly identified artifacts as bands, you can delete 
extraneous bands by selecting the bands and pressing the DELETE key. 
You can also increase the Noise Factor and/or Scale Factor values to 
exclude more data and click Find Bands again.

• If Fragment Analysis overlooked some bands, you can mark them yourself 
using the editing tools (section 4.2). You can also decrease the Noise Factor 
and/or Scale Factor values to include more data and click Find Bands again.

For more information on the Noise Factor and Scale Factor parameters, see 
section 9.5.2.
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Figure 3-11.   Finding bands.

To try it now…

1. In the Band Finder inspector, click Find Bands. Found bands are marked 
with bars (indicating the areas of maximum intensity) and rectangles 
(indicating the band region). 

2. Click Done. The Band Statistics inspector appears (figure 3-12).

3. Go to section 3.12.
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3.12 Reviewing the band statistics
The Band Statistics inspector (figure 3-12) displays the following information 
about any band you select. To select a band, click the band marker. Handles 
appear on the marker to indicate the band is selected. 

• Lane Number—The number automatically assigned to the lane.

• Lane Name—The name you assigned to the lane.

• Lane Type—The lane designation, such as Size or Unknown.

• Band Number—The band’s position in the lane, counting from the top.

• Band Name—A box in which you can type a band name (click Set).

• Size/pKI—The calculated size or isoelectric point, in the units you specified.

• Rf—The distance traveled, expressed as a percentage of the migration 
distance, measured from the top of the lane to the selected band.

• Distance—The distance traveled (in millimeters) from the top of the lane to 
the band position (region of greatest intensity).

• Amount—The calculated amount in the units you specified.

• Volume—The sum of all the pixel intensity values in the band, minus the 
background (background is determined automatically).

• Source—The method used to locate the band: 

- Auto—Fragment Analysis found the band. 

- Semiauto—Fragment Analysis found the band after you indicated its 
general location.

- Manual—You indicated the location of the band.

• Percent—Percent of band volume relative to all bands in the lane.

The Band Statistics inspector is the end of the analysis. Go to chapter 4 for 
more information about the Band Statistics inspector as well as for instructions 
on creating a report, saving your specifications, saving the analysis, automating 
the analysis, and more. See section 9.6.1 for additional details about band 
statistics.
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Figure 3-12.   Obtaining band statistics.

To try it now…

1. Place the pointer on a band marker and click the mouse button. Handles 
appear on the marker (if they do not, click again). Statistics for that band 
appear in the inspector (figure 3-12).

2. Repeat step 1 for the other bands. Compare the values on the standards 
labels with the values displayed in the Size box of the inspector.

3. Go to chapter 4 to continue the tutorial. 

In chapter 4, you will use the magnification tool, edit the bands, create and 
print a report, save the entries you made during this session, automate the 
analysis, and then exit Fragment Analysis.

If you want to quit now, you can save the analysis, and then retrieve it 
and finish the tutorial later. (See section 4.8.1 for instructions on saving
the analysis; see section 4.9 for instructions on quitting the analysis.) 
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Chapter 4 Post-analysis operations 
step-by-step

This chapter explains the tasks you can perform after completing the analysis. 
It also continues the tutorial that started in chapter 3. The tutorial portion of 
this chapter assumes that you have completed an analysis and that the analyzed 
image and Band Statistics inspector are displayed.

The topics in this chapter are—

• Inspecting the bands (section 4.1)
• Editing the bands (section 4.2)
• Creating a report (section 4.3)
• Printing the results (section 4.4)
• Exiting from Excel (section 4.5)
• Saving your specifications (section 4.6)
• Automating the analysis (section 4.7)
• Saving the experiment analysis (section 4.8)
• Closing the Fragment Analysis software (section 4.9)
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4.1 Inspecting the bands
When the Band Statistics inspector appears, isobar lines are added to the image 
as well as labels (on the outermost standards lanes) showing the molecular 
weights or isoelectric points of the standards bands. 

4.1.1 Checking the isobar lines
Isobar lines connect the standards bands that Fragment Analysis used to 
calculate the values of the unknown bands. The lines should generally follow 
the “smile” of your gel caused by electrophoresis anomalies. If they do not 
appear correct, check to see that all the standards bands were found. If they 
were not, use an editing tool (section 4.2) to identify the missing bands or to 
delete the spurious bands, and then click Recalculate. 

When checking the bands, note that values for unknown bands that fall below 
the lowest or above the highest standards band are extrapolated. 

4.1.2 Magnifying portions of the display
The Magnifier tool is a “magnifying glass” for enlarging selected areas of 
the display (figure 4-1). To use this tool, click the Magnifier button ( ) on 
the toolbar (or select the Magnifier command from the Tools menu). With the 
pointer (now a cross shape) on the Image window, drag the Magnifier around 
the Image window to view different areas. 

4.1.3 Changing the line and label attributes
You can hide the isobar lines, labels, lane numbers and names, and/or band and 
lane marking objects. You can also change the color of any of these objects as 
well as display intensity profiles of each lane. To do this, open the View menu 
and select Display. The Display window appears. 

Check boxes in the Display window allow you to select and deselect objects, 
such as lane profiles, that you want to show or hide. A color menu allows you 
to change object colors. Click Apply to apply your changes to the selected 
objects or Save to save and apply the changes to all subsequent analyses. 

For more information on using the Display window, see section 7.9.
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Figure 4-1.   Using the Magnifier to inspect bands.

To try it now…

1. On the toolbar, click the Magnifier button ( ), and then place the 
pointer anywhere in the image and hold down the mouse button. A 
magnifying glass appears (figure 4-1).

2. Drag the glass around the image to examine the bands, and then release 
the mouse button.

3. Click Select ( ) to end the Magnifier mode.

4. Open the View menu and select Display. The Display window appears.

5. In the Display window, click the Lane Profile box to select it, and then
click Apply followed by Close. Profiles, indicating the intensity of each 
band, appear on the image.

6. Go to section 4.2.
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4.2 Editing the bands
Special band-editing buttons on the toolbar (or their counterpart commands on 
the Tools menu) allow you to identify bands not found by Fragment Analysis 
or to remove bands from the analysis. For example, if the system identified 
two close bands as a single band, you can delete the band marker, and then 
add two new bands.

4.2.1 Using the band-editing buttons
Three band-editing tools are available:

For manually creating a band. Click the Draw Band (Manual) button, 
and then move the pointer to the area where you want to create a 
band. Drag the pointer diagonally to create a rectangle that surrounds 
the band (figure 4-2). When you release the mouse button, a band 
marker is inserted in the center of the rectangle you created.

For finding a band semiautomatically. Click the Draw Band 
(Semiautomatic) button, and then move the pointer to the area in 
which you want the system to determine the band position. Drag
the pointer diagonally to create a rectangle that defines the band size. 
When you release the mouse button, a band marker is inserted in the 
area of maximum pixel intensity. 

For deleting a band marker. Click a band (or bands, by holding down 
the SHIFT key), and then click the Delete Band button or press the 
DELETE key. 

To end the drawing mode, click the Select button ( ).

4.2.2 Recalculating the data
After adding or deleting band markers, click the Recalculate button to instruct 
Fragment Analysis to recalculate the data. If you add or delete standards bands 
and recalculate, the isobar lines are redrawn.

4.2.3 Naming bands
To label a band with a unique name, click the Band Name box, and then type 
a name and click Set. The band name appears in the report.
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Figure 4-2.   Editing bands.

To try it now…

1. Click the Draw Band (Manual) button ( ).

2. Move the pointer to an empty spot in any lane of the Image window, and 
then drag the pointer to draw a rectangle (figure 4-2). When you release the 
mouse button, a band marker appears.

3. Click Select ( ) to exit the draw mode.

4. Select the band marker within the box you just drew, and then click the 
Delete Band button ( ) to remove the band.

5. In the Image window, click any band. Handles appear on the band and 
statistics for that band appear in the inspector.

6. In the inspector, click the Band Name box, type your name, and then 
click Set.

7. Go to section 4.3.
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4.3 Creating a report
You can create a report that shows the results of the analysis. Its contents can 
either be transferred to an Excel worksheet (click the Report button), or saved 
for export to a word processing or database application (click the Export 
button). See appendix A for examples of reports.

4.3.1 Report versus Export
Buttons on the Band Statistics inspector let you choose either Report or Export. 
(Alternatively, you can select Generate Report or Export Results from the
File menu.) 

• Report—Displays the Report window (figure 4-3) for specifying report 
contents. After you make your selections and click the Report button,
the Fragment Analysis Report window appears. Double-click in this 
window to transfer the results to Excel. (Data must be saved from Excel.) 
See section 6.5 for details.

• Export—Displays the Export window for specifying report contents. 
After you make your selections and click the Save As button, the Save 
Export File window appears. In the File Name box, type a name for the 
report, and then click OK. Fragment Analysis adds either a .txt or .csv 
extension, depending on whether you select tab or comma as the field 
separator character (delimiter). See section 6.4 for details. 

4.3.2 Specifying the report contents
The Report and Export windows allow you to choose among three report 
formats. To select one of the formats, click one of the buttons. To select 
the contents for Band Reports (band characteristics) and Lane Reports (lane 
numbers), click the down arrow ( ) next to the box to see a list of choices, 
and then select from the list.

• Band Report—Shows information about one band characteristic for 
all lanes. The choice of characteristics is a subset of those listed in the 
Band Statistics inspector. 

• Lane Report—Shows all band characteristics for one lane. 

• Table—Creates a table of all band characteristics for all lanes. 
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Figure 4-3.   Reporting results.

To try it now…

1. In the Band Statistics inspector, click the Report button. The Report 
window appears (figure 4-3).

2. In the Report window, ensure that the Band Report button is selected.

3. Click the down arrow ( ) next to the Band Report box. A list of band 
characteristics appears.

4. Click Rf.

5. Click the Report button. The Report window closes and a different 
window, the Fragment Analysis Report window, appears showing 
the results data.

6. Double-click in the Fragment Analysis Report window. Excel starts with 
your data in a worksheet (figure 4-4).

7. Go to section 4.4.

Double-click the 
window to open
Excel
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4.4 Printing the results
You can print the data report from Excel. After returning to the Fragment 
Analysis application window, you can also print the image as well as the 
Experiment Form.

• Printing the report from Excel—To print the report from Excel, open 
the Excel File menu, and then select Print (figure 4-4). The Print window 
appears. In the Print window, select the print options (or accept the 
defaults), and then click OK. A message appears confirming that the 
report is being printed.

• Printing the image from Fragment Analysis—To print the image from 
Fragment Analysis, open the File menu and select Print Image. The 
Print Options window appears. To accept the default settings, click OK. 
A second Print window appears. To accept the default settings and print 
the image, click OK.

• Printing the Experiment Form from Fragment Analysis—To print the 
current Experiment Form from Fragment Analysis, open the File menu 
and select Print Form. The Experiment Form is printed.
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Figure 4-4.   Printing the report from Excel.

To try it now...

1. Click File in the Excel main window. The File menu appears.

2. Click Print. The Print window appears.

3. In the Print window, click OK. The window closes and the report is sent to 
the default printer. 

4. Go to section 4.5.
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4.5 Exiting from Excel
Before leaving Excel, you might want to save your report. To retrieve a file 
saved in Excel, use the Open command from the Excel File menu.

4.5.1 Saving your report
To save your Excel worksheet, open the File menu and select Save Copy As. 
The Save As window appears (figure 4-5). In the File Name box, type a name 
for the report (Excel adds the .xls extension), and then click OK. A Summary 
Information window appears. Click OK, unless you want to add information 
about the report.

4.5.2 Closing the worksheet
To close the worksheet, double-click the control menu button ( ) of the 
worksheet.

4.5.3 Exiting Excel
To exit Excel, you can either close the application, reduce it to an icon, or 
move it to the bottom of the window stack—

• Close—To close the application, double-click the control menu button 
( ) located on the Excel application window (not the worksheet 
window). 

• Reduce to an icon—To reduce Excel to an icon, click the minimize button 
( ) near the upper right corner of the Excel window. This action leaves 
Excel running in the background and speeds processing when you again 
transfer data from Fragment Analysis to Excel.

• Hide the Excel worksheet—To bring Fragment Analysis to the front of the 
window stack, hold down the ALT key and press TAB until the Fragment 
Analysis window appears. Repeat to display Excel. 
p4-10 ● Fragment Analysis User’s Guide



Chapter 4   Post-analysis operations step-by-step
Figure 4-5.   Saving the worksheet.

To try it now…

1. Open the Excel File menu and select Save Copy As. The Save As window 
appears (figure 4-5).

2. In the File Name box, type your name, and then click OK. (Excel adds
the .xls extension.) A Summary Information window appears. Click OK.

3. Double-click the control menu button ( ) of the worksheet window (not 
the Excel main window). The worksheet closes.

4. On the Excel title bar, click the minimize button ( ). Excel is reduced to 
an icon below (or behind) the Fragment Analysis window.

5. In the Fragment Analysis window, double-click the control menu button 
( ) of the Fragment Analysis Report window. A message asks if you want 
to activate Excel. Click No. The Report window closes.

6. Go to section 4.6.
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4.6 Saving your specifications
Before exiting the session, you can update the Experiment Form with the 
entries you added during the analysis session. 

4.6.1 Specifications that are saved
When you save the specifications you entered during the analysis, you are 
updating the Experiment Form with the following:

• The degree of image rotation
• The size of the largest band (small rectangle)
• The region of interest (large rectangle)
• The type of experiment
• The interpolation methods
• The number of lanes in the sample
• The spacing between lanes (select Use Lane Positions)
• The standards file information
• The location of the standards and unknown lanes
• Band and lane names and descriptions
• The noise and scale factor parameters

Some parameters, such as noise and scale factor, are not displayed on the form. 
Nevertheless, they are saved.

4.6.2 The save procedure
To save the specifications, click the Show Form button in the Band Statistics 
inspector (or open the File menu, click Experiment Form, and then click Show 
from the submenu). The current Experiment Form appears. Click the Save 
button to add the new specifications to the form.

If you want to save the lane positions, make sure the Use Lane Positions check 
box (Lane Setup window, figure 4-6) has an X in it.

4.6.3 Creating a new form based on the current form
To save the specifications under a new name (create a new Experiment Form), 
click the Save As button. When the Save As window appears, type a new name 
in the File Name box, and then click OK. The new parameters are saved to a 
new Experiment Form and the original Experiment Form is retained.
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Figure 4-6.   Saving your specifications.

To try it now…

1. On the Band Statistics inspector, click the Show Form button. The 
Experiment Form you created appears.

2. Note that the standards file you created appears in the Standards 
Filenames area.

3. In the Experiment Form, click the Lane Setup button. The Lane Setup 
window appears (figure 4-6). 

4. In the Lane Setup, click the Use Lane Positions check box to save any 
adjustments you made to the lane positions, and then click OK. (An 
X should appear in the box.) The Lane Setup window closes.

5. In the Experiment Form, click Save. Your new specifications are saved.

6. Go to section 4.7.

Click here to save lane 
positions
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4.7 Automating the analysis
You can automate all or part of the analysis process. You do this by accessing 
the Automation Options window from the Experiment Form, and then 
choosing the steps you want to automate.

4.7.1 Accessing the Automation Options window
To access the Automation Options window, display the Experiment Form 
window, and then click the Automation button. The Automation Options 
window appears (figure 4-7). After you make your selections in the 
Automation Options window, click OK. Then in the Experiment Form, 
click Save to implement your selections.

4.7.2 Selecting the steps to automate
In the Automation Options window, click the check boxes to indicate which 
steps you want to automate. You can select any or all the steps. If you select 
all the steps, Fragment Analysis performs the entire analysis automatically, 
ending with creating a report file. 

If you select the Export box, additional options appear. The options allow 
you to select the report format and contents, the same as those discussed 
on section 4.3. To make your selections, click the boxes to display menus, 
beginning with Report Type—

• Report Type—Choose among Table Report, Band Report, and 
Lane Report.

• Report Options—The options you see depend on whether you select 
Band Report or Lane Report. (No options appear for the Table report 
type, because all information for all lanes and bands is reported.)

• Delimiter—Select either Tab Separated or Comma Separated to insert 
either a tab or comma between the data fields.

Fragment Analysis automatically names the report the same as your form 
file name, but adds either a .txt or .csv extension, depending on the delimiter 
option you choose. The file is then available for export to a word processing or 
database application.
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Figure 4-7.   Selecting steps to automate.

To try it now…

1. From the Experiment Form, click the Automation button. The Automation 
Options window appears.

2. Click all the boxes in the Automation Options window except Export 
(figure 4-7), and then click OK.

3. In the Experiment Form, click Save, and then click Close. The Experiment 
Form closes.

4. In the Band Statistics inspector, click in the Panes window to display a 
list of inspectors, and then click Image Setup. The Image Setup inspector 
appears with the rectangles located where you placed them.

5. Click Done. Fragment Analysis performs the complete analysis.

6. After the analysis is complete, click the Show Form button on the
Band Statistics inspector. When the Experiment Form appears, click 
the Automation button to open the Automation Options window. Next, 
deselect all automation options and click OK, and then click Save and 
Close in the Experiment Form.

7. Go to section 4.8.
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4.8 Saving the experiment analysis
Before exiting Fragment Analysis, you can save the final results of 
the analysis—just the way it appears at the end of a session. You can then 
retrieve the results (the objects and the data they represent) for further work.

4.8.1 The save procedure
To save the experiment analysis, click the Save Analysis button in the 
Band Statistics inspector (or open the File menu, select Experiment Analysis 
to display a submenu, and then select Save). The Save Analysis File window 
appears (figure 4-8). In the File Name box, type a name for the analysis file, 
and then click OK. (Fragment Analysis adds the .exp extension.)

4.8.2 Retrieving the saved experiment analysis
To retrieve the saved experiment analysis, first load the image from which the 
analysis was saved (section 3.5). Next, open the Fragment Analysis File menu 
and select Experiment Analysis, and then select Open from the submenu. 
The Open Analysis File window appears. In the list of file names, locate the 
analysis file, and then double-click it (or click the file name, and then click OK). 
The saved analysis appears. The objects are displayed on the image and the 
Image Setup inspector is replaced by the Band Statistics inspector.

You can now reexamine the experiment results and generate additional reports 
using the procedure described in section 4.3.

If you click Show Form, a form named formn.frm is displayed (where n is a 
unique number assigned by the computer). It shows the experiment parameters 
associated with the saved analysis. If you save this form, it becomes the new 
active form.
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Figure 4-8.   Saving the analysis.

To try it now…

1. In the Band Statistics inspector, click the Save Analysis button. The 
Save Analysis File window appears (figure 4-8).

2. In the File Name box, type image1, and then click OK. The window 
closes.

3. Double-click the control menu button ( ) of the Image window. A 
message asks if you want to save the experiment analysis. Click No (you 
already saved it). Both the Image window and inspector close.

4. From the File menu click Open Image. The Open Image window appears.

5. Double-click tutor1.ds. The Image window and Image Setup inspector 
appear.

6. In the File menu, click Experiment Analysis, and then click Open. The 
Open Analysis File window appears. 

7. From the list of files in the Open Analysis File window, double-click 
IMAGE1. The objects, such as isobar lines and band markers, appear 
on the image together with the Band Statistics inspector (figure 4-9).

8. Go to section 4.9.
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4.9 Closing the Fragment Analysis software 
When you are finished using the Fragment Analysis software, you should close 
all the open windows and then close the Fragment Analysis software. 

4.9.1 Closing the Image window
To close the Image window, double-click the control menu button ( ) on 
the Image window (figure 4-9). If you did not previously save the experiment, 
a message appears asking if you want to save the experiment. If you select Yes, 
the Save Analysis File window appears. Type a name for the analysis file, and 
then click OK.

4.9.2 Closing the Report window
If the Fragment Analysis Report window is open, double-click the control 
menu button ( ) of this window to close it. A message appears, asking if you 
want to reopen Excel. Click No, unless you forgot to save the report and want 
to do so.

4.9.3 Closing Fragment Analysis
To close the Fragment Analysis software, double-click the control menu button 
( ) in the application main menu, or select Exit from the File menu.
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Figure 4-9.   Closing the saved analysis.

To try it now…

1. Double-click the control menu button ( ) of the Image window. When 
a message appears asking if you want to save the experiment analysis, 
click No. Both the Image window and inspector close.

2. Double-click the control menu button ( ) of the Fragment Analysis main 
menu. The Fragment Analysis window closes.

The tutorial is concluded. For additional information on the features and 
functions discussed in chapters 3 and 4, see the Reference part of this guide.
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Chapter 5 Dual-channel image 
analysis

The Fragment Analysis software can analyze two-channel (dual-channel) 
images. Two-channel data collection allows you to increase efficiency 
and accuracy.

The topics in this chapter are—

• What is a dual-channel image? (section 5.1)
• How to create a dual-channel image (section 5.2)
• Examples of two-channel experiments (section 5.3)
• Setting up for dual-channel image analysis (section 5.4)
• Running a dual-channel image analysis (section 5.5)
• Dual-channel reporting (section 5.6)
• Automating dual-channel image analysis (section 5.7)
• Saving a dual-channel image experiment analysis (section 5.8
• Loading a saved dual-channel image experiment analysis (section 5.9)

5.1 What is a dual-channel image?
A dual-channel image results from the collection of two separate sets of 
data from one sample. When you load a dual-channel image, the two sets 
of data are displayed in a side-by-side view (figure 5-1).
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Figure 5-1.   A side-by-side, dual-channel image.

Fragment Analysis uses the side-by-side view for analysis. However, you can 
display the two-channel image separately, as an overlay, or side by side in 
one Image window. Buttons on the toolbar allow you to change the views:

Channel 1—Only the channel 1 data.

Channel 2—Only the channel 2 data.

Overlay—A composite of the channel 1 and channel 2 data.

Side by Side—Channel 1 and channel 2 data in separate sides of the 
Image window. 
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5.2 How to create a dual-channel image
You create a dual-channel image by labeling two sets of sample material (such 
as two sets of unknowns) with two different fluorescent dyes. The emissions 
(signals) from the two dyes are of different wavelengths. 

The instrument collects data for the two fluorochromes separately, using 
different filters to collect the emissions of the two fluorochromes (figure 5-2).

Figure 5-2.   Diagram showing two-channel data collection.

Note: Before analyzing a dual-channel image, you must first separate 
overlapping emission spectra using the FluorSep™ utility.

5.3 Examples of two-channel experiments
Two-channel experiments can be set up to serve a variety of purposes. In 
particular, two-channel experiments allow you to load two samples in a single 
lane, thereby increasing your efficiency. You can also ensure accuracy by 
running standards and unknowns in the same lane, thereby eliminating 
problems caused by smiling lanes or other gel artifacts.

Figures 5-3 and 5-3 show examples of two-channel experiments.

Emission
filter A

Emission
filter B

Photomultiplier 
tube detector

Emission
signals

Sample Overlay image Side-by-side image

Dye 1=Legend: Dye 2=
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Figure 5-3.   Placing two samples per lane—labeled with different dyes—to increase sample throughput. 

(Lanes 1, 4, and 7 contain standards and unknowns; lanes 2, 3, 5, and 6 contain only unknowns.)

Figure 5-4.   Placing standards and unknowns—labeled with different dyes—in the same lanes to ensure 

accuracy of analysis.
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5.4 Setting up for dual-channel image analysis
To prepare for dual-channel image analysis, access the Experiment Form 
and complete the form twice, once for each channel.

Note: You can practice performing a two-channel analysis using the 
tutor2.ds image file available in the tutor directory. For both the channel 1 
and channel 2 images, use the same lane setup information as you did with 
the single-channel tutorial. You can load the standards file (sizestd) you 
created in the single-channel tutorial.

To prepare the Experiment Form—

1. Open the File menu and select Experiment Form, and then select New 
from the submenu (or select Open if you want to create a new form based 
on an existing form). The Experiment Form appears (figure 5-5).

Figure 5-5.   Entering parameters for the channel 1 image.

2. Complete the form for the channel 1 data (make sure that a 1 appears in 
the Channel selection box).

Note: If you want to automate the analysis, select the automation options 
as part of the set up. See section 5.7 for more information.
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3. Click Lane Setup. The Lane Setup window appears with the lanes for 
channel 1 listed in the Lane List box (figure 5-6).

Figure 5-6.   The Lane Setup window.

4. Complete the Lane Setup form for your channel 1 data, and then click OK. 
The window closes. 

5. In the Experiment Form, click the down-arrow ( ) next to the Channel 
box, and then select 2 from the list.

6. Set the analysis parameters for the channel 2 data (if different from the 
channel 1 parameters).

7. Click Lane Setup. The Lane Setup window appears again with the lanes for 
channel 2 listed in the Lane List box and a 2 displayed in the Channel box.

8. Complete the Lane Setup form for your channel 2 image, and then click 
OK. The window closes.

9. In the Experiment Form window, click Save (or click Save As, if you 
are modifying an existing form). The Save Form File window appears. 

10. In the Save Form File window, type a name for your form, and then 
click OK.

Note: For detailed information on completing the Experiment Form, see 
sections 3.1 through 3.4 and section 6.1.
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5.5 Running a dual-channel image analysis
Running a dual-channel image analysis is the same as running two 
single-channel image analyses in sequence except that you perform the first
two steps—Image Setup and Lane Finding—only once. (The parameters you
set in those two inspectors affect both images.) 

After you prepare the Experiment Form and load a dual-channel image, 
perform the analysis as follows:

1. With the channel 1 (left) side of the Image window active, perform a 
complete analysis, as described in chapter 3.

Note: To activate an image, click in the image area (not on the title bar). 
The frame around a portion of the window darkens. 

2. At the conclusion of the analysis (after you have reached the Band Statistics 
inspector), double-click the channel 2 image. Fragment Analysis returns to 
the Lane Setup step so that you can continue the analysis of the channel 2 
data.

3. Complete the analysis for channel 2. 

Notes: 

If you did not specify a separate standards file for channel 2, Fragment 
Analysis uses the standards specified for channel 1. 

If, after completing an analysis, you save to the Experiment Form any 
new region of interest, prototype band size, noise factor, or scale factor 
parameters that you entered during the analysis session, only the 
parameters for channel 1 are saved, not for channel 2.

5.6 Dual-channel reporting
The procedure for creating a dual-channel report is the same as that for 
creating a single-channel report (section 4.3). You create the report after 
analyzing each image. First, perform the analysis for the channel 1 side of 
the Image window, and then create your report for that image. Next, perform 
the analysis for the channel 2 side of the Image window, and then create
your report for that image. The channel 2 report is appended to the 
channel 1 report.
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5.7 Automating dual-channel image analysis
You automate dual-channel image analysis by setting the automation options 
first for the channel 1 image, and then for the channel 2 image as part of setting 
up a dual-channel experiment. 

If you want the analysis to be completely automated (image 1 analysis followed 
by image 2 analysis), select all automation options for the channel 1 setup, 
including Export, as well as all automation options for the channel 2 setup 
(Export optional). If you want to omit Export, you will need to double-click 
image 2 after the image 1 analysis is complete to start the image 2 automated 
analysis.

5.8 Saving a dual-channel image experiment 
analysis

To save a dual-channel image experiment analysis—

1. Complete the analysis for both the channel 1 image and the channel 2 
image. 

2. When you reach the Band Statistics inspector for the channel 2 image, 
click the Save Analysis button (or open the File menu, select Experiment 
Analysis to display a submenu, and then select Save). The Save Analysis File 
window appears. 

3. In the File Name box, type a name for the experiment analysis file, and then 
click OK. (Fragment Analysis adds the .exp extension.)

5.9 Loading a saved dual-channel image 
experiment analysis

To load a saved experiment analysis—

1. Load the image from which the experiment was saved. 

2. Open the Fragment Analysis File menu and select Experiment Analysis, 
and then select Open from the submenu. The Open Analysis window 
appears. 

3. In the list of file names, locate the experiment analysis file, and then 
double-click it (or click the file name, and then click OK). The saved 
experiment appears. The objects are displayed on both images and the 
Image Setup inspector is replaced by the Band Statistics inspector for 
whichever image is active. (To see the statistics for the other image, 
double-click the image.)
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Chapter 6 File menu

The File menu contains commands for accessing the Experiment Form, 
managing and printing files, generating reports, and exiting Fragment Analysis.

The topics in this chapter are—

• Experiment Form (section 6.1)
• Experiment Analysis (section 6.2)
• Open Image (section 6.3)
• Export Results (section 6.4)
• Generate Report (section 6.5)
• Delete (section 6.6)
• Rename (section 6.7)
• Print Image (section 6.8)
• Print Form (section 6.9)
• Print Setup (section 6.10)
• Exit (section 6.11)
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6.1 Experiment Form
The Experiment Form command displays a submenu with the following 
options:

• New—Opens a blank Experiment Form. (The form contains some default 
settings for running an analysis.) Select this option if you want to create a 
new Experiment Form. This option is available only if no image is loaded, 
or when the Image Setup inspector is displayed.

• Open—Displays the Open Form File window from which you select an 
existing form. Select this option to load an Experiment Form, modify a 
form, or create a new form based on an existing form. To open an existing 
Experiment Form, locate the form name on the File Name list and 
double-click the name (or click once, and then click OK). This option 
is available only if no image is loaded, or when the Image Setup inspector
is displayed.

• Show—Displays the Experiment Form that is currently in effect. This 
option is available only at the beginning of the analysis session (Image 
Setup), at the end (Band Statistics), and whenever a form is loaded by
itself (no image). If you did not load a form at the beginning of the analysis, 
the Show command displays a form containing the entries you made during 
the session. You can then save the form.

• Close—Unloads the Experiment Form that is currently in effect. After 
selecting this option, you can run an analysis without using a form. 
This option is available only at the beginning of the analysis session 
(Image Setup), at the end (Band Statistics), and whenever a form is 
loaded by itself (no image).

6.1.1 About the Experiment Form
Use the Experiment Form (figure 6-1) to set the parameters for running the 
analysis and to create a record of each experiment. By creating a form, you 
can partially or fully automate fragment analysis. After you create a form, 
it is automatically loaded and ready to use for the analysis. The name of the 
form appears on the right side of the status bar.

The form you load remains in effect until you create a new form, load another 
existing form, or close the form using the Close command in the Experiment 
Form submenu.

You can create a new form for each analysis—thereby keeping a separate 
record of each—or you can create just a few forms to use repeatedly for 
experiments that are similar to one another.
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You need not prepare a form to perform an analysis. If you do not use a 
form, you can enter parameters, such as the number of lanes in the sample
and the location of the standards lanes, into each inspector. At the end of 
an analysis session, you can then choose to save the parameters to create 
an Experiment Form. 

Figure 6-1.   The Experiment Form set for a DNA type experiment.

6.1.2 Entering information for your records
Use the following text boxes to create a record of your experiment (optional):

• Experiment ID—Type any text to use for identifying your experiment.

• Date—Type a date in the box, or click the Today button to enter the 
current date.

• General Comments—Type any special notations in this box. 

6.1.3 Entering the number of lanes
In the Number of Lanes box, type the total number of lanes you will be 
analyzing. The number you enter here will be transferred to the Lane Setup 
window.
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6.1.4 Selecting 1 or 2 channels
Use the Channel box to set up the experiment for a one- or two-channel image 
(click the down-arrow to see the second selection). For single-channel images, 
leave the Channel setting at 1. For dual-channel image analysis, first set the 
Channel selection to 1 and fill out the form (including Lane Setup) for the 
channel 1 image, and then set the Channel selection to 2 and fill out the form 
(including Lane Setup) for the channel 2 image. (For more information about 
dual-channel image analysis, see chapter 5.)

6.1.5 Selecting the experiment type
Select the type of experiment you are running from the Experiment Type box. 
The list displays the following experiment types:

• DNA fragment analysis

• Protein fragment analysis

• Isoelectric focusing

Selecting Isoelectric focusing modifies choices on the Experiment Form. For 
example, the Size button changes to pKI (figure 6-2).

Figure 6-2.   The Experiment Form set for an isoelectric focusing type experiment. 
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6.1.6 Selecting interpolation methods
The Interpolation selection boxes allow you to select the curve fit method by 
which Fragment Analysis determines the size, amount, or isoelectric focusing 
point of unknown bands. Note that the curve fit choices can vary according
to the type of experiment you select. 

Before applying the curve fitting calculations, Fragment Analysis 
mathematically superimposes the bands from the standards lanes onto the 
unknown lanes. Isobar lines displayed on the image show the calculated 
location of the standards bands.

Next, Fragment Analysis calculates the curve through the standard points 
in the lane, using the curve fit method you chose in the Interpolation area. 
Finally, the software determines the molecular weight values of the unknowns 
from the standard curve.

You can choose among the following curve fit methods (point to point 
logarithmic is the preferred method):

Point to point linear
Point to point linear uses the following formula to calculate the sizes or 
isoelectric points of the bands based on their migration distances:

distance = – a × MW
or 

distance = – a × pI

where a is a constant determined by the slope of the line between two points on 
the standard curve, MW is the molecular weight, and pI is the isoelectric point. 
(Distance traveled is proportional to the molecular weight or isoelectric point.)

Point to point logarithmic
Point to point logarithmic uses the following formula to calculate the sizes of 
the bands based on their migration distances:

distance = – a × log (MW)
or 

distance = – a × log (pl)

where a is a constant determined by the slope of the line between two points on 
the standard curve, MW is the molecular weight, and pI is the isoelectric point. 
(Distance traveled is proportional to the log of the molecular weight.)

Distance

MW

Distance

log
MW
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Cubic spline (logarithmic)
Cubic spline (logarithmic) uses regression analysis to plot predicted values 
of the unknowns with the observed values of the standards. The regression
line creates a best fit sigmoidal curve through all the data points, and then 
calculates the unknown molecular weights based on their migration distances 
and the log of the standard molecular weights. 

Least squares straight line
Least squares straight line uses regression analysis to plot a best fit straight 
line through all the data points and the origin. Unknown amounts are 
calculated based on total band volumes and unknown molecular weights 
are calculated based on migration distances.

For additional information about how Fragment Analysis calculates unknown 
band values, see appendix B.

6.1.7 Loading the standards file
Before loading a standards file to use for your experiment, you must first 
indicate the type of file to load:

• Size standards files—Contain sizes (molecular weights) of each standard 
band. Size standards file names include a .siz extension.

• pKI standards files—Contain the isoelectric point values (PI) of each 
standard band. pKI standards file names include a .siz extension.

• Amount standards files—Contain the amount of material—in units such 
as nanograms—in each standard band. Amount standards file names 
include a .mas extension.

If you load both amount and size standards in a single lane, load both types 
of standards files.

To select a standards file, click the Size (or pKI) or Amount button. The 
Open Size/Amount window appears. Double-click the file you want to use 
(or click the file name, and then click OK). The file name appears in the
text box.

Alternatively, you can type the name of the file in the text box.

6.1.8 Entering the lane setup information
Click the Lane Setup button to display the Lane Setup window (figure 6-3). 
Use the Lane Setup window to inform Fragment Analysis of the location 
of standards lanes and to add names and descriptive information for your 
records.

Distance

log
MW

Distance/Volume

MW
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Figure 6-3.   The Lane Setup window (available from the Experiment Form).

When the window appears, the lanes are listed in the lane list box (transferred 
from your entry in the Number of Lanes box on the Experiment Form). 
Initially, all lanes are typed as Unknowns.

Specifying the location of standards lanes
To change the lane types from unknown to one of the standards selections—

1. Click the down-arrow button ( ) next to the Type box, and then select 
among the choices on the list (figure 6-4).

Figure 6-4.   Selecting the standards type.

2. In the lane list box, click the lane to which you want to assign the standards 
type designation. (To select multiple lanes, CTRL+click each lane.)

3. Click Set. The type designations change from Unknown to the type of 
standards you selected.
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Assigning names and descriptions to lanes
You can assign identifying names to the lanes and/or add descriptive comments 
regarding the lanes. To do this, first type the name in the Lane Name box and 
the description in the Description box.

Next, in the lane list box, click the lane to which you want to assign the name 
and/or description. (To select multiple lanes, CTRL+click each lane.) Finally, 
click Set. The names and descriptions are added to the lane list box.

Editing the lane list
To remove a line from the lane list, click the lane, and then click Remove. 
To add an entry to the list, first make sure that the information about the new 
lane, such as type and lane name, is displayed in the Lane Setup window. Next, 
click the lane name below which you want to insert a new lane, and then 
click Insert. Fragment Analysis renumbers the lanes.

Saving the changes to the lane positions
The Use Lane Positions check box allows you to save the adjustments you 
make to the lane positions after Fragment Analysis has marked them. For 
example, if, during the Lane Finder step, you move one of the lane markers, 
you can retain the new positions for subsequent analyses. Otherwise, 
Fragment Analysis recalculates the lane positions each time you perform 
an analysis.

Note that the Use Lane Positions box appears only after you have completed
an analysis session.

6.1.9 Selecting automation options
Click the Automation button to obtain a list of automation options 
(figure 6-5). 
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Figure 6-5.   Automation Options window, no options selected.

How automation works
To automate the analysis, you click the boxes next to the steps you want 
to automate (an X appears in the box). You can select any or all steps. 
Fragment Analysis uses the parameters in the currently loaded Experiment 
Form to automate the analysis. (If you are not certain that the region of 
interest—indicated on the image by the large rectangle—is appropriate for
the image you have loaded, it is best not to automate the Image Setup step.) 

About the automation options
Checking the automation options for the inspectors produces the following 
results:

Image Setup—Sets the region of interest and the prototype band size, 
implements the Image Setup parameters, rotates the image (if applicable), 
and displays the Lane Finder inspector.

Lane Finder—Finds lanes, and then displays the Lane Setup inspector.

Lane Setup—Implements the lane setup parameters, and then displays the 
Standards Setup inspector.

Standards Setup—Implements the standards parameters, and then displays
the Band Finder inspector.

Band Finder—Finds bands, and then displays the Band Statistics inspector.
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Exporting the results automatically
Selecting the Export option instructs Fragment Analysis to automatically
create a report file containing the results of the analysis. The file, which you
can export into a word processing or database application, is automatically 
assigned the same name as the Experiment Form (but with a different 
extension). For example, if your form name is sample1.frm, your report 
file will be sample1.txt (or sample1.csv). If you have previously used an 
Experiment Form to export a report automatically, a message will appear 
asking whether you want to overwrite the previously created report.

When you click the Export box, new items appear in the Automation Options 
window, giving you the opportunity to select the report type, report contents, 
and field delimiter type from selection boxes (figure 6-6).

Figure 6-6.   The Automation Options window, all options selected.

To automate exporting—

1. Click the Report Type box. A list of report options appears:

• Band Report—Shows information about one band characteristic for 
all lanes. The characteristics options, available from the Report Option 
menu, are a subset of those listed in the Band Statistics inspector. 

• Lane Report—Shows all band characteristics for one lane. 

• Table—Creates a table of all band characteristics for all lanes. 
(No Report Option is available for Table reports because all data 
is reported.)
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2. Click the Report Option box, and then choose the report contents:

• For a Band Report type, select the band characteristic, such as Size or 
Rf, for which you want a report.

• For a Lane Report type, select the lane for which you want a report.

3. Click the Delimiter box, and then select one of two options:

• Tab Separated—Inserts a tab between fields and creates a file with a .txt 
extension. 

• Comma Separated—Inserts a comma between fields and creates a file 
with a .csv extension.

6.1.10 Saving the Experiment Form
To save to the specifications that you entered directly or that were 
automatically entered during an analysis session, click the Save button. 
The Save Form File window appears (figure 6-7). 

Figure 6-7.   Saving an Experiment Form.

Type a name for the form in the File Name box, and then click OK. (Fragment 
Analysis adds the .frm extension.) You can retrieve the form by selecting 
Experiment Form from the File menu, and then clicking Open from the 
Experiment Form submenu.

Note: Do not use the following characters: .”^:<>+=;’ and space. You can use 
the underline character.
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6.1.11 Saving the form to a new name
The Save As button allows you to change an existing form file and save it to 
a new name. 

After modifying an existing form, click Save As. The Save Form File window 
appears. In the File Name box, type a name for the form, and then click OK. 
The original form is retained with its original file name. The modified version 
of the form is given the new name. (Fragment Analysis adds the .FRM 
extension.)

6.1.12 Closing the window
Select Close to close the Experiment Form window. If you have changed the 
form, Fragment Analysis will ask if you want to save the changes before closing 
the window. 

6.2 Experiment Analysis
The Experiment Analysis command allows you to save and retrieve the 
analysis, including the objects (band markers, lane markers, and so forth), 
and the calculated data. 

Clicking Experiment Analysis displays a submenu with two options:

• Open—Displays the Open Analysis File window. To retrieve an analysis 
file, locate the file in the list of files, and then double-click the file name 
(or click the file name, and then click OK). The objects appear in the Image 
window in the same state as when you saved the experiment. The Band 
Statistics inspector also appears.

• Save—Displays the Save Analysis File window. To save the analysis, type 
a name in the File Name box, and then click OK. Fragment Analysis adds 
the .exp extension.

You save an analysis when the session is complete (the Band Statistics inspector 
is displayed). You can initiate the Save command from either the Experiment 
Analysis submenu or by selecting Save Analysis from the Band Statistics 
inspector.

You retrieve (open) a saved experiment after loading the image from which the 
experiment was saved.
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6.3 Open Image
The Open Image command displays the Open Image window (figure 6-8). 

Figure 6-8.   The Open Image window.

To open an image file, locate the file name among the list of files and
double-click the name (or click the file name, and then click OK). 

6.3.1 Locating the file you want
When you open the window, the File Name box initially displays *.ds;*.gel, 
indicating that all the files listed are image datasets or files. Below the 
File Name box is a list of existing .ds and .gel files.

If the file name is not listed, check that—

• The list represents the correct file type (section 6.3.2)

• The directory is correct (section 6.3.3)

• The drive is correct (section 6.3.4)

• The file is located in a shared directory on another workstation
(section 6.3.5).

You can use the File Name box to type the name of the file you want to display. 
If the file you want is stored in a different directory than the one displayed,
you must include the full path. For example:

 c:\data\dna.ds
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6.3.2 Selecting a file type
The List Files of Type selection box displays the type of files currently listed in 
the File Name box. The default setting is for .ds and .gel file types. To change 
file types, click the List Files of Type box to display a menu of file types, and 
then click one of the options. A new list of files appears in the file list box.

6.3.3 Changing the directory
The Directories area displays the current directory path. The general directory 
structure is as follows:

Double-click the root directory (c:\) to display a list of directories. After you 
locate the correct directory (in most cases, the data directory), double-click it. 
Its contents appear in the files list box. 

Note: The .dir folders listed under the data directory, identify the special 
directories that hold the image datasets and associated files. Do not open a 
.dir folder to access your dataset. Your dataset is available to you by opening 
the data directory and selecting the correct .ds file. If you should accidentally 
delete the .ds file, you can obtain a copy of it in the .dir folder that has the
same name as the dataset. (Copy the .ds file to the data directory.)

6.3.4 Changing drives 
The Drives box displays the current drive. To change drives, click the Drives 
box to display the list of drives, and then click the option you want. The list
of files stored on that drive appears in the files list box.

6.3.5 Connecting to shared directories 
The Network button displays the Connect Network Drive window. Use this 
window for connecting to shared directories on the network. For detailed 
instructions on using this window, click the Help button located in the window.

6.4 Export Results
The Export Results command displays the Export window (figure 6-9). Use 
this window to specify the contents and format of a report and save it for 
export to a word processing or database application. Reports you create 
contain the results of an analysis session. 
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Figure 6-9.   The Export window.

After selecting the format and contents (sections 6.4.1 and 6.4.2), click Save As 
to open the Save Export File window.

6.4.1 Selecting the format and contents
You can choose among three report formats. To select one of the formats, click 
the appropriate button.

• Band Report—Shows information about a selected band characteristic, 
such as size, amount, or distance, for all lanes. To select a particular 
characteristic, click the down arrow next to the Band Report box. A list
of characteristics appears. Click the characteristic for which you want 
a report.

• Lane Report—Shows all band characteristics for one lane. To select a lane, 
click the down arrow next to the Lane Report box. A list of lanes appears. 
Click the lane for which you want a report.

• Table—Creates a table of all band characteristics for all lanes. 
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6.4.2 Selecting the field delimiter
The Field Delimiter selection buttons allow you to choose either tabs or 
commas as the separator characters between fields in the report.

• Comma—Inserts a comma between field entries in the report and creates 
a Comma Separated Values (.csv) file type. 

• Tab—Inserts a tab between field entries in the report and creates a 
Tab Separated Values (.txt) file type. 

Note: Use Tab for export to Excel.

6.4.3 Naming the report
After you click the Save As button in the Export window, the Save Export File 
window appears (figure 6-10) with either *.txt or *.csv displayed in the 
File Name box, depending on the delimiter you selected.

Figure 6-10.   Naming the report.

In the File Name box, type a name for the report file. Fragment Analysis 
automatically adds the .csv or .txt extension, depending on the field delimiter 
you select. Click OK. Your file is saved.
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6.5 Generate Report
The Generate Report command displays the Report window (figure 6-11). 
Use this window to specify the contents and format of a report that you can 
transfer to an Excel worksheet. Reports you create contain the results of an 
analysis session. 

Figure 6-11.   The Report window.

6.5.1 Selecting the format and content
You can choose among three report formats. To select one of the formats,
click the appropriate button.

• Band Report—Shows information about a selected band characteristic, 
such as size, amount, or distance, for all lanes. To select a particular 
characteristic, click the down arrow next to the Band Report box. 
A list of characteristics appears. Click the characteristic for which 
you want a report.

• Lane Report—Shows all band characteristics for one lane. To select a 
lane, click the down arrow next to the Lane Report box. A list of lanes 
appears. Click the lane for which you want a report.

• Table—Creates a table of all band characteristics for all lanes. 

After making your selection, click on the Report button. The Report window 
closes and the Fragment Analysis Report window appears, showing your 
analysis data in tabular form. (You cannot save or print from this window.)
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6.5.2 Transferring the results to Excel
To transfer the results to Excel, double-click the Fragment Analysis Report 
window. Excel starts and your report data appears in a worksheet. (For 
information about saving and printing the report from within Excel, see 
sections 4.3 through 4.5.)

6.6 Delete
The Delete command displays the Delete window. The delete window is nearly 
identical to the Open Image window (section 6.3). To delete a file (or dataset), 
locate the file name and click it. The name appears in the File Name box. 
Click OK. A message asks you to confirm the deletion.

The Fragment Analysis file type extensions are:

• .gel—Single image file.

• .ds—Image dataset file. A .ds file is actually a “pointer” file. Selecting 
a .ds file instructs Fragment Analysis to retrieve the image and associated 
files from the special directory (.dir directory) in which they are stored. 

• .frm—Experiment form file.

• .exp—Analyzed image file.

• .siz—Size standards file or pKI standards file.

• .mas—Mass (amount) standards file.

• .txt—Tab-separated report file.

• .csv—Comma-separated report file.

Note: Always use the Fragment Analysis Delete function to delete image files. 
You cannot delete an Experiment Form file that is currently loaded. (Select 
the Close option from the Experiment Form submenu.)
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6.7 Rename
The Rename command displays the Rename window (figure 6-12). 

Figure 6-12.   The Rename window.

To rename a file—

1. Type the name of the file in the From box. (Include the path if the file is 
located in a directory or drive that is different from the current directory 
or drive.) 

Alternatively, you can click the Select File button to display the Select 
Source File window, and then select a file just as you do when selecting a 
file from the Open Image window (section 6.3). The file name, including 
the path, is automatically inserted in the From box. 

2. In the To box, type the new name for the file. (Include the path if you want 
to store it in a different drive or directory.) 

3. Click OK.

To use an existing file name as the base for a new name, click the To box, and 
then click Select File. The Select New Name window appears. Click an existing 
file name, and then change the name in the File Name box. (An error message 
appears if you try to save the file using the same name.)

Note: You cannot rename an Experiment Form file that is currently loaded. 
(Select the Close option from the Experiment Form submenu.)
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6.8 Print Image
The Print Image command displays a Print Options window for printing the 
image (figure 6-13). Select centering and scaling options, and then click OK. 
A second window appears in which you specify the pages to print and the 
number of copies. 

To change from portrait to landscape orientation or to change the size of 
the paper, click Setup. The Print Setup window appears. The choices in this 
window are printer dependent, but at a minimum allow you to determine the 
page orientation. See your printer documentation for more details.

Figure 6-13.   The Print Options and Print windows.

6.9 Print Form
The Print Form command allows you to print the Experiment Form. To print 
the Experiment Form, select the Print Form command. The current form is 
printed.

6.10 Print Setup
The Print Setup command displays the Print Setup window. You can also access 
this window by clicking the Setup button in the Print window. Use this window 
to set preferences for print orientation and two-sided printing. The exact 
contents of this window are printer dependent. See your printer documentation 
for more detail. 
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6.11 Exit
The Exit command closes Fragment Analysis. You will be prompted to save 
any open files.
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The View menu includes commands for modifying the image display. In 
this chapter, View menu options that are also available from the toolbar are 
identified with the appropriate toolbar icon.

The topics in this chapter are—

• Actual Size (section 7.1)
• Full Size (section 7.2)
• Zoom In (section 7.3)
• Zoom Out (section 7.4)
• Magnification (section 7.5)
• Grey/Color Adjust (section 7.6)
• Map (section 7.7)
• Dual Channel (section 7.8)
• Display (section 7.9)
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7.1 Actual Size
The Actual Size command displays the image at 100%, which is the actual size 
of the sample. To display the image at the actual size of the sample, click the 
Actual Size command.

Note: The 100% actual size applies to 17-inch monitors with 1024 by 768 
pixel array, or 13-inch monitors with 640 by 480 pixel array. For monitors that 
vary from these specifications, the display may vary slightly from the actual 
sample size.

7.2 Full Size
The Full Size command scales the image to fit within the Image window 
boundaries. To display the full image, click the Full Size command.

7.3 Zoom In
The Zoom In command doubles the size of the image. The center point of 
the Image window is maintained. To enlarge the image, click the Zoom In 
command.

7.4 Zoom Out
The Zoom Out command halves the size of the image. To reduce the image, 
click the Zoom Out command.

7.5 Magnification
The Magnification command displays a menu of magnification percentages. 
To magnify or reduce the image, click one of the percentages listed in the menu.
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7.6 Grey/Color Adjust
The Grey/Color Adjust command displays the Grey/Color Adjust window 
(figure 7-1). (To close the window, click the Close button.) This window 
graphically reflects the intensity of the image displayed in the Image window. 

Figure 7-1.   The Grey/Color Adjust window.

7.6.1 What the Grey/Color Adjust window does
Your monitor can display 256 levels of grey, but an image file can contain up 
to 46,700 levels of intensity. The Grey/Color Adjust window allows you to 
view your data more clearly by excluding some of the unused intensity levels 
(background and unused high values) of your image. In this way, you evenly 
distribute the relevant image data over the 256 levels of grey.

You can also use the Grey/Color Adjust window to change the contrast, 
brightness, and color of the image.

Note: Changing the image display using the Grey/Color Adjust window affects 
only the display. The original image and quantitation results are not altered.

Maximum Range Value

Range Adjust Bar

Intensity Profile

Minimum Range Value

Log/exp

Brightness

Contrast

High Display Level

Low Display Level
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7.6.2 Changing the display levels
Because the range of intensity levels in the image may not extend over the 
complete range of possible values, you set limits to the upper and lower display 
levels to eliminate unused values. In this way, the 256 possible grey levels are 
spread over a narrower range of intensity values. 

The Grey/Color Adjust window provides an interactive mechanism, the 

range adjust bar, for setting display limits. As you use the bar to change the 
display limits, color is added to the bar and the image display. Green shows
the pixels that will be assigned the intensity value shown in the Hi box; purple 
shows the pixels that will be assigned the intensity value shown in the Lo box 
(background).

Using the range adjust bar (single-channel images)
You can use the range adjust bar to change the image display limits of a
single-channel image—

• To change the high display limit—Place the pointer at the top of the 
range adjust bar and drag the pointer down (figure 7-2). When the bands 
begin to turn green (indicating high intensity areas), move the pointer up 
slightly until the bands are again black, and then release the mouse button.

• To change the low display level—Place the pointer at the bottom of the 
range adjust bar and drag the pointer up. When the background is purple 
(indicating low intensity areas), but the bands are still unaffected, release 
the mouse button.

• To change both levels together—Place the pointer in the middle of the 
range adjust bar, hold down the SHIFT key, and drag the pointer up and 
down.

To save the setting, click Set Range. The image redisplays with the new settings 
and the intensity profile graph in the Grey/Color Adjust window changes to 
reflect the settings. 

To restore the image to its original display limit values, click the Reset button. 
You can only reset the display limits if you have not clicked Set Range. To 
expand the display limits after you click Set Range, type new values in the 
Hi and Lo boxes.

Note: For instructions on changing the display values for dual-channel images, 
see section 7.6.6.
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Figure 7-2.   Adjusting the upper range.

Setting range values beyond those displayed
To set the display limit values above or below those displayed in the Hi 
and/or Lo boxes (or to set display levels for dual-channel images), delete the 
current value in one or both of the boxes, type the new value, and then click 
Set Range. If you are setting levels for dual-channel images, click the side of
the dual-channel Image window you want to change to activate it before 
changing the limit settings. (For additional information about working with 
dual-channel images, see section 7.6.6.)

7.6.3 Adjusting brightness and contrast
Three buttons allow you to adjust brightness and contrast. Adjustments you 
make with the buttons are temporary. They are not saved with the image and 
they do not affect the data.

To adjust brightness and contrast, click one of the buttons described below, 
and then move the pointer to the intensity profile area, hold down the mouse 
button and move the line. 

Adjusts brightness. Move the line up to increase the brightness (pixel 
intensity), and down to decrease the brightness. 

Repositioning the square (bend point) on the intensity profile changes 
the center of rotation. Use the brightness button to move the square, 
and then use the contrast button to change the contrast.

Adjusts contrast. Moving the line closer to vertical increases the 
contrast.

Range Adjust Bar
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Adjusts brightness and contrast together. Moving the pointer up 
and to the left increases the contrast at the lower range of intensity 
values and decreases the contrast at the upper range of intensity 
values (logarithmic display). Moving the pointer down and to the 
right increases the contrast at the higher intensity values and decreases 
the contrast at the lower intensity values (exponential display).

Click Reset to return to the original display values.

7.6.4 Adding color to the displayed image
To add color to the displayed image, click the Palette box. A list of color 
choices appears. Click one of the color choices.

7.6.5 Inverting the current values
To invert the current display values, click the Invert check box. The intensity 
profile and the displayed pixel values invert. Click the Invert check box again 
to turn Invert off.

7.6.6 Working with dual-channel images
If you are viewing a dual-channel image, the Grey/Color Adjust window 
operates as follows:

Active and nonactive sides of the Image window
The display levels reflect the active side of the window. To activate one side of 
the window, click the image. The title bar of the Grey/Color Adjust window 
displays the number of the active window (1 or 2). 

The range adjust bar
The range adjust bar does not operate in dual-channel mode. To change display 
levels, type values in the Hi and Lo boxes.

Brightness and contrast controls
The brightness and contrast controls work independently for each window. For 
the channel 1 image, use the right mouse button to operate the brightness and 
contrast controls. For the channel 2 image, use the left mouse button.
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Side-by-Side (Two Color) mode
In the Side-by-Side (Two Color) mode—

• The color palette changes to two-color schemes, such as red/green. You 
select the combination you want from the list in the Palette area.

• Two lines appear on the intensity profile. The line colors correspond to 
the channel colors.

• Each color in a two-color scheme is displayed in 15 gradations. You can 
increase the number of gradations in one of the images by decreasing 
the number in the other image. (The minimum and maximum numbers 
are 2 and 118, respectively.) 

For example, instead of viewing both images in 15 gradations, you can 
view one image in 3 and the other in 78 gradations. To do this, move the 
pointer into the range adjust bar of the Grey/Color Adjust window and 
click the right mouse button. A pop-up menu appears displaying the 
gradation options. Click one of the options using the left mouse button.

For information on the choices of dual-channel display modes and how they 
work, see section 7.8.

7.7 Map
The Map command displays a small version of the Image window, including 
an outline that shows the portion of the image currently displayed (figure 7-3). 
It also allows you to change the displayed area.

To reposition the image display, place the pointer on the interior outline and 
drag the outline to a new location. The main image display moves to reflect the 
new outline location.

To move the Map window, move the pointer into the Map window, and then 
SHIFT+drag the window to a new location. 

To return the Map window to the upper left corner of the Image window, 
position the pointer in the Map window and click the right mouse button. 
Select Reset from the pop-up menu.

To close the Map window, click the Map command or the Map toolbar button.
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Figure 7-3.   The Map window.

7.8 Dual Channel
The Dual Channel command opens a menu of display controls for 
dual-channel images.

The Dual Channel menu provides the following commands:

Overlay—Displays a composite image of two separate images. 
Each filter is represented by a different color. Areas where both filters 
produced a signal are shown in a third color. For example, when red 
and green overlap, yellow is produced. In this way, you can differentiate 
between isolated sample signals and merged sample signals, such as 
comigrating electrophoresis bands.

Side by Side (Two Color)—Displays each channel (separated image) 
in a separate side of the Image window. The color representing each 
channel is displayed in its respective side.

Channel 1—Displays, in grey scale, the image created by channel 1.

Channel 2—Displays, in grey scale, the image created by channel 2.
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Side by Side (Grey/Color)—Displays each channel (separated image) 
in a separate side of the Image window, using the same color scheme
for both images. This command is not available from the toolbar.

Synchronize—Links two images together so that you can scroll, 
magnify, enlarge, and reduce both images simultaneously. This 
command is not available from the toolbar.

7.9 Display
The Display command displays the Display window (figure 7-4). Use this 
window to hide and show objects, such as lane markers, band position 
markers, and the graph profile, and to change their colors. 

Figure 7-4.   The Display window.

To show or hide an object listed in the window, click its check box (an X in 
the box denotes show). To select a color for the object, click its associated color 
box to display a menu of colors, and then click the color of your choice.

The buttons on the bottom of the screen work as follows:

• Save—Retains the choices and closes the window.

• Cancel—Closes the window without applying the new selections.

• Apply—Applies the changes without closing the window, but does not save 
the changes.

• Close—Closes the window.
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The Tools menu includes commands for careful examination of the image. 
Tools menu selections change the function of the pointer from the select mode 
to a mode for performing a specific task. For example, in the Magnifier mode, 
the pointer becomes a magnifying glass. The pointer remains in that mode 
until you select another function or the Select option. 

Note: Tools options are also available from a pop-up menu. To access the 
pop-up menu, place the pointer in the Image window and click the right 
mouse button, and then use the left mouse button to select a command. 

In this chapter, if a Tools option is available from the toolbar, the appropriate 
toolbar icon is also shown.

The topics in this chapter are—

• Select (section 8.1)
• Pan (section 8.2)
• Pixel Locator (section 8.3)
• Pixel Distance (section 8.4)
• Enlarge (section 8.5)
• Reduce (section 8.6)
• Zoom Area (section 8.7)
• Magnifier (section 8.8)
• Add Band (Manual) (section 8.9)
• Add Band (Semiautomatic) (section 8.10)
• Delete Band (section 8.11)
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8.1 Select
The Select command returns the pointer from an editing or special viewing 
mode to the select mode. In Select mode, you can select one or more objects on 
the image (such as rectangles). To select one object, click the object. To select
a group of objects, place the pointer in the image area next to one of the objects 
and drag the pointer diagonally to surround the group with a rectangle.

8.2 Pan
The Pan command enables scrolling in any direction. To use the Pan tool, 
select the Pan command from the menu or from the toolbar. Place the pointer 
on the image. The pointer changes to a hand. Hold down the mouse button 
and move the hand to drag the image up, down, left, or right. Click Select
from the menu or toolbar ( ) to end the Pan mode.

8.3 Pixel Locator
The Pixel Locator command allows you to determine pixel locations and 
intensity values. To determine pixel locations, select Pixel Locator from the 
menu or toolbar. The pointer turns into a cross. Place the pointer over the 
image and click the mouse button. A cross appears on the image and pixel 
information appears on the left side of the status bar. When you release
the mouse button, the information shifts to the right side of the status bar. 
The locator mark remains on the image until you return to the Select mode. 

The information displayed includes the x and y location of the selected pixel
(P) and the intensity value of the pixel. (To see the raw pixel value—prior 
to conversion to the units used by the software—hold down the CTRL key 
while clicking.) 

If you mark the image with both the Pixel Locator and the Pixel Distance tools, 
you can switch the information on the status bar from one type to the other by 
clicking the Pixel Locator or Pixel Distance toolbar button.

8.4 Pixel Distance
The Pixel Distance command allows you to measure the distance between 
pixels. To measure distance, select Pixel Distance from the menu or toolbar. 
The pointer turns into a cross. Drag the pointer to draw a line on the image. 
The information appears on the left side of the status bar. After you release 
“the button, the information shifts to the right side of the status bar. The 
information includes the Po (pixel coordinates at point of origin), the Pf (pixel 
coordinates at the final point), and the distance in mm between the two points. 
The line remains on the image until you return to the Select mode. 
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To add the distance in pixels to the status bar display, CTRL+drag the pointer 
across the area you want to measure.

If you mark the image with both the Pixel Locator and the Pixel Distance tools, 
you can switch the information on the status bar from one type to the other by 
clicking the Pixel Locator or Pixel Distance toolbar button.

8.5 Enlarge
The Enlarge command doubles the image magnification. To enlarge an image, 
select Enlarge from the menu, and then click the image area you want to 
enlarge. The point at which you placed the pointer becomes the center of the 
image. Click Select from the menu or toolbar ( ) to end the Enlarge mode.

8.6 Reduce
The Reduce command halves the image magnification. To reduce an image, 
select Reduce from the menu, and then click the area you want reduced. The 
point at which you placed the pointer becomes the center of the image. Click 
Select from the menu or toolbar ( ) to end the Reduce mode.

8.7 Zoom Area
The Zoom Area command displays a menu for creating and viewing a stack of 
enlarged image frames that can be redisplayed in reverse order.

Create Frame—Magnifies a selected image area. To magnify a selected 
area, click Create Frame from the menu or toolbar. Place the pointer 
on the image and drag the pointer diagonally to create a frame. After 
you release the button, the area you selected expands to fill the window.

Repeat the process to create a series of frames. The series is saved 
until you redisplay the frames using the Previous Frame option or 
select the Reset option. (The series is not saved when you close the 
Image window.)

Previous Frame—Displays the previous frame. If you created a series 
of frames using the Create Frame tool, Previous Frame allows you to 
view the series (stack). To view the stack, click Previous Frame from 
the menu or toolbar. Move the pointer into the image area and click
to view the previously created frame. Continue clicking to cycle 
through the remaining frames in the stack.

Reset—Resets the image to its original view, deleting any previously 
created frames. This command is not available on the toolbar.

Click Select from the menu or toolbar ( ) to end the Zoom Area modes.
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8.8 Magnifier
The Magnifier command creates a magnifying glass for examining selected 
areas of the image. To use the Magnifier, select the Magnifier command from 
the menu or from the toolbar. The pointer changes to a cross. Hold down the 
mouse button. A rectangular magnifying glass appears that enlarges the target 
area to the next magnification level (section 7.5). Release the mouse button 
to remove the Magnifier. You can drag the Magnifier around the Image 
window to view different areas. 

The status bar displays the magnification as well as the upper left 
pixel coordinates (Pi), and the lower right (Pf) pixel coordinates of the 
magnified area.

To increase and decrease the magnification, press the plus or minus keys 
on the numeric keypad while holding down the mouse button. Click Select 
(from the menu or toolbar) to end the Magnifier mode.

8.9 Add Band (Manual)
The Add Band (Manual) command allows you to manually identify a band that 
was not found using the current band-finding settings. To create a band, click 
Add Band (Manual) from the menu or toolbar, and then move the pointer to 
the area where you want to create a band. Drag the pointer diagonally to create 
a rectangle that defines the band size. When you release the mouse button, 
Fragment Analysis inserts a band marker in the center of the rectangle you 
created. Click Select from the menu or toolbar ( ) to end the draw mode.

8.10 Add Band (Semiautomatic)
The Add Band (Semiautomatic) command instructs Fragment Analysis to 
insert a band marker in the area of maximum pixel intensity within an area you 
define. To draw a band semiautomatically, click Add Band (Semiautomatic) 
from the menu or toolbar, and then move the pointer to the area in which 
you want the system to locate a band. Drag the pointer diagonally to create 
a rectangle that defines the band size. When you release the mouse button, 
Fragment Analysis inserts a band marker in the area of maximum pixel 
intensity. Click Select from the menu or toolbar ( ) to end the draw mode.
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8.11 Delete Band
The Delete Band command deletes a selected band. To delete a band, first 
click the band you want to delete, and then click Delete Band from the menu 
or toolbar. The band marker is deleted. (You can also delete selected band 
markers using the DELETE key.) To select multiple bands for deletion, 
SHIFT+click the bands.
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The commands on the Analysis menu enable you to access the inspectors
you use to perform an analysis. The availability of each inspector depends 
on the stage of analysis you have reached. Each inspector contains a Help 
button. All but the Band Statistics inspector contain a Done button. The 
Help button accesses information about the inspector. The Done button 
displays the next inspector. 

Note: To use the keyboard to switch between an inspector and the Image 
window, press ALT+F6.

The topics in this chapter are—

• Image Setup (section 9.1)
• Lane Finder (section 9.2)
• Lane Setup (section 9.3)
• Standards Setup (section 9.4)
• Band Finder (section 9.5)
• Band Statistics (section 9.6)
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9.1 Image Setup
The Image Setup command displays the Image Setup inspector (figure 9-1) 
together with two rectangular objects on the image. You can move and resize 
the rectangles to define the area of interest and the largest band size. The 
Image Setup inspector allows you to rotate the image, to select the experiment 
type and interpolation method, and to add experiment-specific information 
for your records.

Figure 9-1.   The Image Setup inspector.

If you load an existing Experiment Form at the Image Setup step, the settings 
for the area of interest and band size (the two rectangles) are not in effect. 
(Fragment Analysis recognizes the default settings as changes to the form.)
You will need to readjust the rectangles.
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9.1.1 Selecting the experiment type
To select the experiment type, click the down-arrow button ( ) next to the 
Experiment Type box. A list of experiment type options appears. Click the 
option of your choice (DNA, isoelectric focusing, protein).

9.1.2 Specifying the number of lanes
To specify the number of lanes in your sample, type the number in the 
Number of Lanes box. Fragment Analysis uses this information to find lanes.

9.1.3 Entering information for your records (optional)
You can use the ID, Date, and General Comments boxes to add information 
for your records. The information you enter here is not used for the analysis 
but is included in the report. These three text entry boxes duplicate those 
on the Experiment Form.

• ID—Use the ID box to type identifying information for your experiment.

• Date—You can type a date in the Date box, or click the Today button
to enter today’s date in the box.

• General Comments—Use the General Comments box to type additional 
notes about your experiment.

9.1.4 Selecting an interpolation method
You can choose among the various curve fit methods listed in the Size (or pKI) 
and Amount selection boxes. (you should use the point-to-point logarithmic 
for size standards.)

To see the options, click the down-arrow ( ) next to one of the boxes. Click 
one of the options to change the curve fit method. Note that the choices vary 
depending on the experiment type you select.

Point to point linear
Point to point linear uses the following formula to calculate the sizes or 
isoelectric points of the bands based on their migration distances:

distance = – a × MW
or 

distance = – a × pI

where a is a constant determined by the slope of the line between two points 
on the standard curve, MW is the molecular weight, and pI is the isoelectric 
point. (Distance traveled is proportional to the molecular weight or 
isoelectric point.)

Distance

MW
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Point to point logarithmic
Point to point logarithmic uses the following formula to calculate the sizes of 
the bands based on their migration distances:

distance = – a × log (MW)
or 

distance = – a × log (pl)

where a is a constant determined by the slope of the line between two points 
on the standard curve, MW is the molecular weight, and pI is the isoelectric 
point. (Distance traveled is proportional to the log of the molecular weight.)

Cubic spline (logarithmic)
Cubic spline (logarithmic) uses regression analysis to plot predicted values
of the unknowns with the observed values of the standards. The regression 
line creates a best fit sigmoidal curve through all the data points, and then 
calculates the unknown molecular weights based on their migration distances 
and the log of the standard molecular weights. 

Least squares straight line
Least squares straight line uses regression analysis to plot a best fit straight 
line through all the data points and the origin. Unknown amounts are 
calculated based on total band volumes and unknown molecular weights 
are calculated based on migration distance.

For additional information about how Fragment Analysis calculates unknown 
band values, see appendix B.

9.1.5 Rotating the image
To rotate an image that is not squarely aligned with the Image window,
click the image rotation button ( ). A red line with black handles at both 
ends appears down the center of the image. You move the line to indicate how 
the bands should be vertically aligned. Drag the line itself to move the line. 
Select the handles to rotate the line (figure 9-2).

Align the rotation line with a column of bands that form a lane. For best 
results, choose a column near the center of the image.

Click the Rotate button. The image shifts to the degree indicated by the line.

Distance

log
MW

Distance

log
MW

Distance/Volume

MW
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Figure 9-2.   Moving the rotation line to the right shifts the image to the left.

9.2 Lane Finder
The Lane Finder command displays the Lane Finder inspector (figure 9-3) 
together with a lane marker (a new rectangle on the image) that serves as a 
pattern for finding lanes. Use the Lane Finder inspector to initiate automatic 
lane finding and to adjust the markers that identify lanes.

Figure 9-3.   The Lane Finder inspector.
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9.2.1 Initiating lane finding
To initiate automatic lane finding, click the Find Lanes button. Fragment 
Analysis finds the number of lanes you specified in the Experiment Form or
in the Number of Lanes box of the Image Setup inspector, displays the number 
of lanes found, and identifies the found lanes with rectangular markers. 

9.2.2 Editing lane markers
If the lane markers do not accurately define the lanes, you can move, resize, 
add, or delete them.

Moving lane markers
To move a lane marker, click on it to select it, then place the pointer inside 
the lane, hold down the mouse button, and drag the marker to a new location. 

Resizing Lane Markers
To resize a marker, click on the marker you want to move. Place the pointer 
on one of the edges and drag the edge in or out. 

Note that you can change the width but not the height of the lanes. (The 
height is determined by the size of the region of interest you define in the
Image Setup step.)

Adding and deleting lane markers
You can use the buttons in the Lane Editor box to add and delete lane 
markers—

Adds a selected lane marker. Click the marker you want to duplicate, 
and then click the duplicate button. Fragment Analysis creates a lane 
marker to the right of the selected lane.

Deletes lane markers. Click the lane you want to omit from analysis, 
and then click on the delete button. You can also delete the selected
lane marker by pressing the DELETE key.

9.3 Lane Setup
The Lane Setup command displays the Lane Setup inspector (figure 9-4). Use 
this inspector to indicate which of the lanes on the image are standards lanes 
and to add additional identifying information regarding the lanes.

If you entered this information in the currently loaded Experiment Form, the 
information will appear in the Lane Setup inspector. Unless you want to change 
the information, you need only click Done.
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Figure 9-4.   The Lane Setup inspector.

9.3.1 Identifying lanes
Lane identification is a three-step process—

1. Indicate the lane type by clicking anywhere on the Type box, and 
then selecting the type from the drop-down list: Size Std. (or pKI Std.), 
Size/Amt. Std. (both size and amount standards in the same lane), Amt. Std, 
Unknown, Unused. 

2. Select the lane(s) from the lane list box or from the Image window—

To select one lane at a time, click the lane.

To select more than one lane in the lane list box (such as lane 1 and lane 6), 
CTRL+click each lane number. 

To select contiguous lanes in the Image window, SHIFT+click the first 
and last lane.

To select a group of contiguous lanes in the lane list box, drag through 
the group.

3. After you have identified lanes, click Set. The Type designations in the 
Lane list box change to reflect your choice. 
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9.3.2 Adding descriptive information
You can type a lane name and description in the boxes provided for 
these items. Before entering the information, select the lane(s) to which the 
information applies. (Use the selection techniques described in step 2 of the 
preceding section.)

If you add lane names, they are displayed on the image. To remove the names, 
open the View menu, select Display to open the Display window, and then
click the Lane Name check box to deselect it (remove the X).

9.4 Standards Setup
The Standards Setup command displays the Standards Setup inspector 
(figure 9-5). Use this inspector to load a standards file, modify the file, or create 
a new standards file. The standards file provides the information needed to 
compute the values of the unknowns. The inspector changes slightly depending 
on whether you select an isoelectric focusing experiment or a DNA/protein 
experiment, as shown in figure 9-5.

Figure 9-5.   Standards Setup inspector for an isoelectric focusing experiment type 

(left) and a DNA/protein experiment type (right).

If you specified a standards file name in the currently loaded Experiment Form, 
the standards information will be in place. You need only click Done.
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9.4.1 Three types of standards files
The analysis software handles three types of standards: size standards, amount 
(quantity) standards, and pKI standards. 

• Size standards files—Contain the sizes (molecular weights) of the standards 
bands. Size standards file names include a .siz extension.

• Amount standards files—Contain the amount of material—in units such
as nanograms—in each standard band. Amount standards file names 
include a .mas extension.

• pKI standards files—Contain the isoelectric point values of the standards 
bands. The pKI standards file names include a .siz extension.

9.4.2 Creating a standards file
To create a standards file, you specify a value (size, amount, or isoelectric 
point) for each band in the standards lane—

1. Click one of the Type buttons (Size Std/pKI Std or Amount Std).

2. In the Unit box, type the unit, such as bp. 

3. Select the sorting order by clicking one of the Order buttons: Ascending, 
Descending, or Manual. (If you select Manual, use the Before and After 
buttons to specify where you want the value to be inserted.)

4. In the Value box, type the value for the first band.

5. Press ENTER (or click Add). The value appears in the list box.

6. Repeat steps 4 and 5 for each remaining band value. 

7. Click Save As. A window for naming the file appears. 

8. In the File Name box, type a name for the file, and then click OK. Fragment 
Analysis adds the extension, either .siz or .mas.

9.4.3 Loading an existing standards file
To load an existing standards file—

1. Click either the Size Std (or pKI Std) or Amount Std button.

2. Click Open. The Open Size/Amount File window appears.

3. In the list of files, double-click the name of the file you want to use (or click 
the name and then click OK). The file name appears in the Standards File 
box and the values appear in the list box.
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9.4.4 Loading two sets of standards
If you are using both size/pKI and amount standards—either in the same or 
separate lanes—first select one of the standards types (such as Size Std), and 
then load the file as explained in section 9.4.3. After you load one file, select 
the second standards type, and then load the second file. To switch the band 
value display from one file type to another, click the standards button in the 
Type area.

9.4.5 Modifying the Standards Values
You use the Add, Change, and Delete buttons to change the values in the 
list box.

Adding a value
To add a value, in the Value box type the number to add, and then click Add or 
press ENTER. The value is inserted in the appropriate order (either ascending 
or descending, depending on the order you selected). 

Changing a value
To change a value in the list box—

1. In the list box, click the value to change. 

2. In the Value box, type a new value.

3. Click Change. In the list box, the old value is replaced with the new value.

Deleting a value
To delete a value in the list box, click the value you want to delete, and then 
click Delete. The value is removed.

9.4.6 Saving changes to a standards file
If you modified an existing file and want to save the changes, click Save As to 
open the Save window, and then—

• If you modified an existing file and want to save it as a separate file—
leaving the original file intact—type a new name in the File Name box. 

• If you want to save the changes to the existing file, click OK. A message 
asks if you want to replace the existing file. Click Yes.

9.4.7 Deleting a standards file
To delete a standards file, select the Delete command from the File menu 
(section 6.6). When the Delete window appears, search for .siz or .mas files, 
select the file you want to delete, and then click OK.
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9.5 Band Finder
The Band Finder command displays the Band Finder inspector (figure 9-6). Use 
this inspector to initiate and control band finding. 

Figure 9-6.   The Band Finder inspector.

9.5.1 Finding bands
To initiate band finding, click the Find Bands button. Fragment Analysis—

• Locates the bands in all selected lanes.

• Marks each found band with a boundary marker and band position 
marker.

If Fragment Analysis incorrectly identifies artifacts as bands or overlooks 
bands, use the editing tools to make corrections (sections 8.9 through 8.11) 
and/or adjust the Noise Factor or Scale Factor (section 9.5.2) to change the 
band-finding parameters, and then initiate band finding again.

Note: If you want to see a profile representing the pixel intensity of the 
bands, open the View menu, select Display, and then click in the Lane Profile 
check box.
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9.5.2 Adjusting the band-finding parameters
The Noise Factor and Scale Factor boxes allow you to fine-tune the parameters 
that govern band finding. By changing the values in the boxes, you can instruct 
Fragment Analysis to find either more or fewer bands.

Note: You can apply different band-finding parameters to the different groups 
of lanes selectable from the Scope buttons. For example, you can apply one 
set of parameters to Size standards (select the Size button) and a different 
set to Unknowns (select the Unknown button). You can also apply different 
parameters to individual lanes or groups of lanes you select from the Image 
window. However, parameters applied to individual lanes are not saved to the 
Experiment Form.

The Noise Factor parameter
The default Noise Factor value of 1.0 represents the threshold setting 
established by Fragment Analysis. The threshold indicates the point at which 
Fragment Analysis separated random variations (noise) on the image from 
relevant data. Noise factors are computed for every lane in the image.

To instruct Fragment Analysis to find fewer bands (exclude more data), 
increase the Noise Factor value. Increasing the value moves the threshold 
up to allow more data to be considered as noise and less as bands. 

To instruct Fragment Analysis to find more bands (include more data), decrease 
the Noise Factor value. Decreasing the value moves the threshold down to 
allow more data to be considered relevant and less as noise. 

The Scale Factor parameter
Fragment Analysis uses the default Scale Factor value of 0.25 to remove bands 
from analysis whose left and right sides are significantly different in intensity. 
(The 0.25 value means that the intensity value of the left half of the band must 
be at least 25% of the intensity value of the right half of the band for the band 
to be included.) 

The Scale Factor value is a measure of band uniformity. Decreasing the scale 
factor includes more nonuniform bands in the analysis.
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9.5.3 Limiting band finding to selected lanes
The buttons in the Scope area allow you to limit band finding to a specific 
group of lanes (the default selection is All Lanes). To limit the band-finding 
scope, select one of the buttons in the Scope area, such as Unknown, and then 
click Find Bands.

You can also limit band finding by selecting individual lanes on the Image 
window as follows:

• To select one lane, click the lane. 

• To select multiple lanes one at a time, SHIFT+click each lane. 

• To select a group of lanes, place the pointer outside the upper left corner 
of the first lane you want to select and drag the pointer down to the lower 
right corner of the last lane you want to select. A rectangle encloses the 
lanes until you release the button. Handles on the corners of the lanes 
indicate they are selected. 

• To deselect individual lanes that you selected as a group (see above), 
SHIFT+click each lane you want to deselect.

9.5.4 After you click done—standards bands verification
After you click Done, Fragment Analysis compares the number of bands it 
found in the standards lanes—one lane at a time—with the number of band 
values listed in the standards file. If the number of bands in the lane does
not match the number of bands in the standards file, a message appears
asking if you want to edit the bands. 

• If your response is Yes, the Band Finder inspector remains displayed. 
You can use the editing tools to add or delete band markers.

• If your response is No, the Band Statistics inspector appears. (You can
also edit bands when you reach the Band Statistics inspector, and then
click the Recalculate button.)
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9.6 Band Statistics
The Band Statistics command displays the Band Statistics inspector 
(figure 9-7). This inspector allows you to see a variety of statistics for any
band you select. In addition, from the Band Statistics inspector, you can
access the Experiment Form as well as report the analysis results.

Figure 9-7.   The Band Statistics inspector.

9.6.1 Displaying band statistics
To see the statistics, click any band found by the system. The Band 
Characteristics area displays the following information:

• Lane Number—The lane number assigned by Fragment Analysis.

• Lane Name—The name you assigned to the lane using the Experiment 
Form or the Lane Setup inspector.

• Lane Type—The lane designation: Size Std or pKI Std, Amount Std, 
Size/Amt Std, pKI/Amt Std, Unknown, or Unused.

• Band Number—The band’s position in the lane, counting from the top.
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• Band Name—A text box in which you can type a name for a selected band 
(section 9.6.2).

• Size (or pKI)—The calculated size (or the isoelectric focusing point), in 
the units you specified. 

• Rf—The distance traveled by the band, expressed as a percentage of the 
total migration range, measured from the top to the bottom boundary of 
the lane.

• Distance—The distance traveled (in millimeters) from the top of the lane
to the band position (region of greatest intensity).

• Amount—The calculated amount (quantity) of the band, in the units
you specified.

• Volume—The sum of all the pixel values in the band, minus the 
background.

• Source—The method used to locate the band: 

- Auto—Fragment Analysis found the band.

- Semiauto—Fragment Analysis found the band—within an area 
you specified—using the point of maximal intensity within the area.

- Manual—You specified the band location and dimension by drawing 
a rectangle. Fragment Analysis inserted a marker in the center of 
the rectangle.

• Percent—Percent of band volume relative to all bands in the lane.

Notes: 

The designation, Unassigned, means either that no standards file exists 
for a particular type of calculation (size or amount), that no standard value
is associated with the band (amount type only), or that the current standards
file is inappropriate for the experiment.

The designation, Extr, following a source designation (such as Auto/Extr), 
means that the band is located above or below the highest or lowest 
standards band and that the calculations are based on extrapolation. 
The Extr designation refers to only the size calculation.

9.6.2 Naming bands
To name a band, click the band you want to name, type a name in the 
Band Name box, and click Set.
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9.6.3 Saving the analysis parameters
Fragment Analysis keeps track of the entries you make during an analysis 
session. You can save the entries to create a new Experiment Form (if you 
had not previously created or loaded one) or to update an existing form.

To save the parameters or view the current Experiment Form, click the 
Show Form button. The Experiment Form appears. It contains the parameters 
you entered during the analysis session. 

In the Experiment Form, click Save to save the parameters to the current file 
name or click Save As to assign a name to a newly created form. (For more 
information, see sections 6.1.10 and 6.1.11.)

9.6.4 Saving the experiment analysis
To save the experiment analysis (the objects, such as band markers, and 
the calculated results), click the Save Analysis button. The Save Analysis File 
window appears. In the File Name box, type a name for the analysis, and then 
click OK. Fragment Analysis adds the .exp extension.

To save a dual-channel image experiment analysis, use the Save Analysis 
command after completing the analysis of the channel 2 image.

To retrieve the experiment, first open the image from which the experiment 
was saved. Next, open the File menu, select Experiment Analysis, and then 
select Open from the submenu. A window appears for selecting the file to load.

9.6.5 Creating a report
To create a spreadsheet report of the data, click the Report button to display 
the Report window. The Report window allows you to specify the report 
format, and then transfer the results to Excel. You can also access the 
Report function by selecting Generate Report from the File menu. For more 
information on the Report function, see section 6.5.

9.6.6 Exporting results
To save the data in a file that you can export to a word processing or database 
application, click the Export button. The Export window appears. The Export 
window allows you to specify the report format and open a window for 
naming the file. You can also access the Export function by selecting Export 
Results from the File menu. For more information on the Export function, see 
section 6.4.
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The Window menu includes commands for rearranging windows and their 
components. The topics in this chapter are—

• Show Toolbar (section 10.1)
• Attach Toolbar (section 10.2)
• Show Status (section 10.3)
• Cascade (section 10.4)
• Tile (section 10.5)
• Tile Horizontal (section 10.6)
• Tile Vertical (section 10.7)
• Arrange Icons (section 10.8)
• Close All (section 10.9)
• List of Open Windows (section 10.10)
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10.1 Show Toolbar
The Show Toolbar command displays or hides the toolbar. When the toolbar 
is displayed, a check mark appears next to the Show Toolbar command. To 
show or hide the toolbar, select the Show Toolbar command.

10.2 Attach Toolbar
The Attach Toolbar command attaches or detaches the toolbar to or from 
the right side of the screen. When attached, a check mark appears next 
to the Attach Toolbar command. When detached, you can move the toolbar. 
To toggle between attach and detach, select the Attach Toolbar command.

To move the toolbar, first detach it, and then move the pointer into the title 
bar of the toolbar. Drag the toolbar to a new location, and then release
the mouse button.

10.3 Show Status
The Show Status command displays or hides the status bar at the bottom of
the Fragment Analysis main window. When the status bar is displayed, a check 
mark appears next to the Show Status command. To show or hide the status 
bar, select the Show Status command.

10.4 Cascade
The Cascade command arranges multiple Image windows in an overlapping 
manner. The title bar for each window is displayed and accessible. To arrange 
windows in cascade fashion, select the Cascade command. To bring a hidden 
window to the top of the stack, click its title bar.

10.5 Tile
The Tile command arranges multiple Image windows in a tiled fashion, both 
horizontally and vertically (if more than three are displayed). The image size 
is reduced to accommodate a tiled arrangement. To arrange windows in a tiled 
fashion, select the Tile command. 

10.6 Tile Horizontal
The Tile Horizontal command arranges multiple Image windows side by side 
horizontally. The image size is reduced to accommodate the tiled arrangement. 
To arrange windows horizontally, select the Tile Horizontal command. 
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10.7 Tile Vertical
The Tile Vertical command arranges multiple Image windows side by side 
vertically. The image size is reduced to accommodate the tiled arrangement. 
To arrange windows vertically, select the Tile Vertical command.

10.8 Arrange Icons
The Arrange Icons command realigns icons displayed in a window. To arrange 
icons, select the Arrange Icons command.

10.9 Close All
The Close All command closes all open windows. You will be prompted to 
save files, if appropriate. To close all windows, select the Close All command.

10.10 List of Open Windows
The bottom of the Window menu displays the names of the open windows. 
If the paths to the files are different from the currently displayed document, 
the path names are also displayed. You can select a file name to display a 
hidden file. 
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Appendix A Report examples

The following pages show examples of the three types of reports you can 
create:

• Band Report—Shows the values of one user-selected band attribute, 
such as size, for all bands in all lanes.

• Lane Report—Shows all the statistics for all bands in one user-selected 
lane. 

• Table Report—Shows all information for both bands and lanes.

Reports are divided into two sections. The upper section shows general 
information about the report as well as information collected as part of the 
scanning process. The lower section shows detailed information about lanes 
and bands. The column headings are explained in section 9.6.1. 

The examples on the following pages were created using Excel formatting 
features.
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Appendix B Calculating unknown 
band values

This appendix explains how Fragment Analysis determines the values of 
unknown bands (fragments). The method of determining values for fragment 
size (molecular weight) and isoelectric focusing point is different from that for 
determining fragment amount (quantity).

B.1 Determining the size or isoelectric point of 
unknown bands

After band finding is complete, Fragment Analysis assigns the values listed
in the size standards file or pKI file to the standards bands on the image. 
The assignments are based on the order in which the values are listed in the 
standards file.

Next, standards bands are mathematically superimposed onto lanes containing 
the unknown bands. If the sample being analyzed contains more than one 
standards lane, Fragment Analysis uses the information from the standards 
lanes located on both sides of the unknown. Because bands in the standards 
lanes may not migrate exactly the same distances, Fragment Analysis must 
determine where on an unknown lane to superimpose the standards values. 
To do this, Fragment Analysis performs a point-to-point linear interpolation 
between each band, using the band values of the standards lanes that bracket 
the unknown lane (figure B-1).

Figure B-1.   Fragment Analysis “exports” standards band values into unknown 

lanes, using point-to-point linear interpolation to estimate where to locate the bands.
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Linear interpolation corrects for smiling bands, in which bands of the same 
size migrate at different rates during electrophoresis. 

If an unknown lane is not bracketed by standards lanes (no standard lane on 
either its left or right), size values are exported from only one standards lane 
(its nearest neighbor to the left or right), using horizontal extrapolation 
(figure B-2).

If an unknown band is located above the uppermost standards band or 
below the lowest standards band, its size is estimated using extrapolation. 
Fragment Analysis indicates this condition by adding Extr to the Source field 
in the Band Statistics inspector. For example, the Source designation for a band 
that Fragment Analysis found—and calculated using extrapolation—would
be designated as Auto/Extr.

Figure B-2.   For unknown lanes that are not bracketed by standards lanes,

molecular weight values are exported from only one standards lane, using horizontal 

extrapolation.

Finally, Fragment Analysis computes the size or isoelectric focusing point 
of each band using the interpolation method you select: point-to-point linear, 
point-to-point logarithmic, cubic spline (logarithmic), or least squares straight 
line. (See section 6.1.6 for an explanation of the interpolation methods.)

B.2 Determining the amount (quantity) of unknown 
bands

After band finding is complete, Fragment Analysis assigns the values listed in 
the amount standards file to the standards bands on the image. Assignments 
are based on the order in which they are listed in the standards file.

Fragment Analysis estimates the volumes for all bands. The volumes for 
the mass standards are then used in a linear regression analysis (least squares 
straight line). Next, the volumes of the unknowns are used to compute their 
quantities based on the linear regression (figure B-3).
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Standard bands "exported" 
in a straight line
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Figure B-3.   Fragment Analysis performs regression analysis to determine the 

mass of unknown bands.

If only one mass standard value is listed in the mass standards file, 
Fragment Analysis assumes a second standard with a volume of zero and 
a quantity of zero. 
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Appendix C Troubleshooting

This appendix provides tips on how to avoid and resolve some of the 
problems you may experience when learning to use the Fragment Analysis 
software. Problems, in bold print, are followed by causes and solutions.

C.1 Image setup
After loading an image, the region of interest and prototype band markers 
(large red and small green rectangles) appeared in their default mode 
instead of the way you set them.
You might have forgotten to save the changes you made to the rectangles the 
last time you used this Experiment Form. (After making changes, you must 
display the form and select Save in order to retain new parameters.) Or, you 
might have loaded an Experiment Form after loading the image, in which 
case the default rectangle parameters take precedence. 

To recover from either situation, readjust the rectangles. Then open the File 
menu and select Experiment Form. From the submenu, select Show to display 
the current form. Next, select Save, and then click the Close button. (You can 
also save the changes at the end of the analysis, at the Band Statistics inspector.)

C.2 Lane finding
The lane markers on the outer lane(s) of your image are shifted toward
the center of the image instead of aligned properly over the lane.
The bands in the outer lane(s) do not have high enough signals for accurate 
correlation. To recover, return to the Image Setup inspector and increase 
slightly the width of the region of interest marker (large red rectangle), 
and then click Done. In the Lane Finder inspector, click Find Lanes again.

Curved lanes on the image make it difficult for Fragment Analysis to 
define lanes accurately.
To improve lane finding on images with curved lanes, return to the Image Setup 
inspector and resize the prototype band (the small green rectangle) to make
it narrower (about half a lane width). Note: Do not use this method if you 
are looking for amount information. Also note that band quantitation is not 
accurate for lane markers that do not extend the full lane width. 

You can also try dragging the left and right edges of the region of interest 
(large red rectangle) in or out to change the lane finding routine. Click Done
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to return to the Lane Finder inspector. In the Lane Finder inspector, click 
Find Lanes. If necessary, adjust the lane markers so that they intersect all bands 
in the lane. 

C.3 Lane setup
The settings you specified in the Lane Setup window of the Experiment 
Form did not get transferred to the Lane Setup inspector.
When you enter information in the Lane Setup window of the Experiment 
Form, be sure to click Set before clicking OK. To recover, enter the lane setup 
information in the Lane Setup inspector. (Remember to save the Experiment 
Form at the end of the analysis session: select Show from the Band Statistics 
inspector, and then select Save on the Experiment Form.)

On the Lane Setup window or inspector, when you changed the information 
in either the Type, Lane Name, or Description boxes, the type, lane name, 
or description information that had previously appeared on the selected 
line either disappeared or changed.
You must be sure to set all three boxes—Type, Lane Name, and Description—
to the correct values for the selected lane before clicking Set. (Clicking a line 
does not automatically insert the type, name, and description information into 
their respective input boxes.) To recover, reenter the information, and then 
click Set.

C.4 Band finding
After you click Done in the Band Finder inspector, a Found 0 bands 
message appears.
Be sure to click the Find Bands button before you click Done. To recover, on 
the “Found 0 bands” message window, click Yes, in answer to the Edit bands? 
query, and then click Find Bands.

Fragment Analysis found too many bands (identified artifacts as bands).
The Noise Factor parameter, which controls the separation of relevant from 
irrelevant data, is set too low. Increase the Noise Factor value to raise the 
band-finding threshold (exclude more data from the analysis), and then click 
Find Bands.

Fragment Analysis identified noise spikes as bands.
Most spikes will be excluded as a normal part of the band-finding process. 
(Fragment Analysis ignores spots that are less than half the width of a band.) 
To further exclude spikes, increase the Scale Factor parameter. (The Scale 
Factor value indicates the degree to which the intensity of the left and right 
half of the band must match. For example, a value of 0.30 means that, to be 
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identified as a band, the intensity value of the left half of the band must be at 
least 30% of the intensity value of the right half of the band.)

Fragment Analysis overlooked bands.
The Noise Factor parameter is set too high. To include more data in the 
analysis, reduce the Noise Factor value to lower the band-finding threshold, 
and then click Find Bands.

Bands that are slanted or nonuniform in intensity may also be overlooked.
In such cases, try decreasing the Scale Factor parameter, and then click 
Find Bands again. (For more information about the Scale Factor, see the 
preceding paragraph.)

Bands are difficult to select for deletion.
Be sure that you are clicking on the band marker (the short line) and not the 
band boundary (the box). (Use either the Magnifier or Zoom Area tool for 
a closer look.) If the band marker is difficult to see, open the View menu and 
select Display. On the Display window, turn off the Band Boundary display. 
Also, you can select a color for the band marker that is easier for you to see. 

C.5 Retrieving a saved experiment
When you attempt to retrieve a saved experiment, the Open and Save 
options on the Experiment Analysis submenu are not available.
Be sure to first load the image on which the analysis was saved. To recover, 
open the File menu, select Open Image, and then select the image file. After 
the image appears, load the experiment.
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